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What does it do? 

SD Zones is a trade-finding system used to find so-called Supply Zones and Demand Zones: chart patterns that indicate 
large pockets of institutional sell and buy orders at certain price levels. It shows the zones on TradeStation charts, updated 
in real-time, and provides extensive options to configure zone criteria, time periods to scan and visual appearance. 

It was developed first and foremost to save time and find more potential trades, by scanning a list of symbols in 
TradeStation’s RadarScreen, potentially on multiple timeframes/intervals for each symbol. It then alerts the user when the 
price of a symbol approaches a zone that might be a potential trade setup. 

The scanning is highly optimized, allowing 500 or more symbol rows to be monitored in real-time, detecting newly formed 
zones and keeping track of past ones, while monitoring price as it approaches, touches into or breaks through zones. 

This allows the user to review and qualify a few realistic trade setups, rather than wasting time poring over dozens or 
hundreds of charts on various timeframes to manually look for zones. 

For traders who only trade a few markets/symbols, or who trade other primary strategies than supply/demand, SD Zones 
complements other chart indicators and trade signals, by showing one of the most powerful and reliable forms of 
support and resistance on the chart, helping the trader focus on high probability trades and avoid low probability ones. 

SD Zones works equally well on stocks, futures and forex symbols, taking into consideration the variations of zone patterns 
on different timeframes, and the different criteria for Entry zones (used to time trade entries) versus High Timeframe 
zones (used to gauge “Big Picture” price context and determine preferred trade direction). 

It is equally useful to futures day traders, who watch multiple markets on multiple timeframes for potential trade setups, 
such as during the busy morning hours of the US market; to futures swing traders, who seek larger trades on higher 
timeframe charts; and to stock/options traders, who use SD Zones to scan hundreds of stock/ETF symbols for potential 
trade setups, either in the stocks/ETFs themselves or using powerful supply/demand based options strategies. 

Benefits 

SD Zones can be used by experienced supply/demand traders as well as traders who are new to the technique. Its benefits 
vary depending on each user's background: 

Benefits for experienced supply/demand traders 
• Scan for potential supply/demand setups across hundreds of stocks, futures, index or forex symbols of your choice, to 

quickly locate potential trade setups, without poring over dozens or hundreds of charts. 

• Scan for zones on multiple timeframes, in real-time, anytime, not just once a day like some trading services do. Day 
trades, swing trades, position trades, on any timeframe you want. 

• See at a glance which markets have potential trades coming up within a time threshold you specify: Day traders may 
only be interested in trades coming up in the next 30 minutes, swing traders may be looking for trades coming up in the 
next few hours, while position traders may be interested in the next few days or weeks. 

• Receive alerts when new zones form in a market, which you are otherwise likely to miss unless you happen to be 
looking at the exact right chart when the zone forms. 

• Show zones directly on charts. Not just as static lines, but updated in real-time as price touches into and depletes zones 
or breaks through them, or as new zones form. Zone lines indicate the “freshness” or “depletedness” of zones. You can 
instantly scroll the chart to the base of the zone to inspect it visually. 

• Improve your trading skills by spotting zones that WOULD have been great trades, and easily review whether you could 
have caught them given your trading rules. 

• Complete, ready-to-use TradeStation workspaces to streamline trade finding for Scalping, Day, Swing, XL Swing or 
Position trading in futures, stocks and options. 

• Extensive customization options to fit your preferences for supply/demand criteria, how to draw zones, and how to 
show them on charts. Settings can be made with traditional TradeStation Inputs as well as with an easy-to-use Settings 
panel, which allows changes to be applied to ALL charts and RadarScreen rows with a single mouse click. 

• Pop-up menus in charts and RadarScreen to quickly toggle settings, manage alerts, and invalidate/restore zones. 
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Benefits for ANY trader 
• Automatically show supply/demand zones on your charts, to confirm other trade signals you already use for entries and 

exits; OR to filter out other trade signals when they conflict with supply/demand zones. 

• Demand zones and supply zones are some of the highest probability support and resistance areas – which you might 
not otherwise notice, unless you specifically look for them and your eyes are trained to spot them. 

• Use zones to help improve your entries for higher probability and lower risk. 

• Use zones to select target levels where price might turn or at least pause. 

• Use zones to select stop levels to ensure the smallest sensible risk that still keeps a high probability of avoiding stop-out. 

• Use zones to spot what NOT to trade and filter out trades with low probability. 

• Without knowing much else about supply/demand, these can boost your win rate and profitability considerably. 

The SD Zones indicator comes with a collection of ready-to-use workspaces for stock/options and futures trading. 

In this example, the SD Radar Stocks Daily workspace scans in RadarScreen (to the right) for S&P 500 stocks with 
supply/demand zones on Daily charts and highlights their Demand or Supply cells if they are coming up in the next day 
(changeable to any time threshold  you want). Other columns show the 4-week performance relative to S&P 500, as well 
as the Implied Volatility and IV Percentile of options on the stock.  

Clicking the Symbol cell shows the stock on 60 min, Daily, Weekly and Monthly charts (clockwise from top-left), with real-
time supply/demand zones shown directly on the charts for fast review and qualification of potential setups. The Daily 
chart reflects the zones highlighted in RadarScreen (since this is a Daily workspace). 

The Daily chart also shows Implied Volatility, IV Percentile and a plot of Historical IV to help select the best options 
strategy. The Weekly chart shows the Sector and Industry to help ensure good broad market correlation; it also shows 
Dividend Yield (if any), ExDiv date and number of days to ExDiv date to help select attractive dividend stocks AND to avoid 
pitfalls around dividends (the ExDiv date and number of days turn red 14 days before). 

In addition to the above mentioned IV, IV Percentile, IV Plot, Sector, Industry and Dividends indicators for stock/options 
traders, SD Zones comes with other useful utility indicators for futures traders. 

See SD Radar Stocks workspaces below for details about the Stocks workspaces, and SD Radar Futures workspaces below 
for details about the Futures workspaces (click the links to jump directly to those sections). 
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What are Supply/Demand Zones? 

Supply Zones and Demand Zones are chart patterns indicating prior distribution and accumulation at certain price levels 
by banks, institutions and other large players. Properly identified supply/demand zones can reveal large pockets of unfilled 
sell and buy orders at those price levels, which may cause price to reverse or stall when it revisits them. The zones can also 
be magnets that attract price to those large pockets of orders. 

It is one of the most reliable and time-tested technical analysis methodologies, with roots in the principles of TA titan 
Richard Wyckoff, who back in the early 20th century described the accumulation/distribution methods of “Smart Money” 
operators and the chart patterns they inescapably leave behind. Various trading websites and education providers have 
taught the technique in the last 20 years, as a simplified view of the classic Wyckoff ranges. 

When properly understood, the supply/demand methodology transcends traditional technical analysis tools and indicators, 
which are often based on moving averages and standard deviations, because it reveals the underlying order flow which is 
the original cause of support/resistance levels, trends and other chart patterns in the first place. 

Supply/demand zones can be used as a form of support/resistance levels on charts. When used this way, the zones are 
often applied as confluence for other chart indicators and trading signals, to confirm or disqualify those signals. 

But mastered and used fully, supply/demand is a complete technical analysis methodology and trading strategy, which can 
be used to estimate long and short term price direction, turning points, pullback levels, volatility changes, and 
potential entry and exit points; all with high probability and accuracy. 

A Supply zone (left) and a Demand zone (right) found by the SD Zones indicator, and price reversing after coming back to 
the zones (“revisiting them”). These zones were paired with High Timeframe charts (HTF) to ensure that they aligned with 
the “preferred trade direction” at the time. See Entry zones vs High Timeframe zones under Supply/Demand lessons 
towards the end of this User Guide.  Not all zones work as perfectly as these. 

Supply/Demand zones as trading strategy 

The supply/demand technique can be used as a complete trading strategy, to locate trade setups with low risk, high reward 
AND high probability. While there are different schools of supply/demand strategies, they all share some common 
principles. Refer to the example screenshot below for the following explanation. 

Skilled supply/demand traders will spot a “qualified” supply or demand Entry zone after it has formed, and wait for price to 
revisit (come back to) the zone. They do NOT enter when price first breaks out from the zone, only when it revisits. 

When revisited, traders will then enter a trade at the zone (long at demand zones, short at supply zones) and expect price 
to reverse for a profitable trade. It often does. Depending on the quality of the setup, resting limit orders and exit brackets 
can be used for true set-and-forget trades; or various types of confirmation entries can be employed. The distance to 
“opposing zones” provides an excellent indication of profit potential for the trade and possible targets. 
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The “outside” level of the zone (above a supply zone, below a demand zone) provides an ideal stop placement, as the 
pocket of institutional orders will be depleted if price breaks through the zone. Thus it allows for the smallest sensible risk 
with a high probability of avoiding stop-out. 

There are many variations on this general strategy, including scaling in and out of the position, choosing targets, and 
adjusting entry and stop levels according to zone quality. And then there is a plethora of special options strategies around 
supply/demand. They are a match made in heaven! 

Not all supply/demand trades work out as perfectly as this example, shorting a 5min supply zone in May’21 oil futures. But 
experienced supply/demand traders can testify that trades like this are fairly common – and can seem almost magical to 
other traders who do not know the supply/demand technique. 

Still, losing trades are an unavoidable fact of real-life trading. That is true of supply/demand as well as any other strategy. 
But since most well qualified supply/demand setups offer a generous reward/risk ratio, traders can afford to have several 
losing trades and still remain quite profitable. 

Mastering the Supply/Demand technique 

The principles of the supply/demand technique – what to look for and how to use it – are fairly simple and easy to learn. 
However truly mastering them can take considerable practice and experience. That is true of any worthwhile endeavor in 
life, but particularly true when it comes to pulling money out of thin air in financial markets! 

While this User Guide offers some introduction to and tips on supply/demand (see Supply/Demand lessons towards the 
end) fully teaching it is far beyond its scope. Yet, your success with the SD Zones system will be proportional to your mastery 
of the supply/demand technique. Blindly trading zones suggested by the SD Zones indicator without proper qualification and 
context is likely to be a loosing strategy. 

Many supply/demand traders have received training from Online Trading Academy, who has taught the technique for over 
15 years. The developer of the SD Zones indicator received supply/demand training there in 2009, before undertaking his 
own extensive research of the technique and developing his own strategy rules. 

The developer has recorded various training videos, which also contain supply/demand lessons. They are available on the 
SD Zones Membership page where you also find the latest versions the software, SD Radar workspaces, User Guide and 
other resources. 

Other videos are posted on the @SDzones YouTube channel, which is also a good place to post comments and questions 
for the developer. 

Countertrend short trade off supply zone 

https://www.tradingacademy.com/
https://www.thedailymarketforecast.com/products/sd-zones
https://youtube.com/@sdzones


Supply/Demand Zones System for TradeStation 

8 

Supported TradeStation versions and windows/apps 

The SD Zones software with its included utility indicators and SD Radar workspaces come in versions for both TradeStation 
9.5 and TradeStation 10. Most SD Zones users run TradeStation 10, while the developer uses both TS9.5 and TS10. 

SD Zones works in TradeStation Chart Analysis, RadarScreen and Scanner windows/apps.  

Note that the RadarScreen Platform Feature must be enabled on the TradeStation account in order to use RadarScreen. If 
your TradeStation platform shows only the simpler Quotes window instead of RadarScreen, it means RadarScreen isn’t 
enabled on the account. 

Advanced chart types 

SD Zones detects supply/demand zones using an algorithm which relies on OHLC bars or candles (Open-High-Low-Close) to 
identify specific patterns. It works on all time based charts (Second, Minute, Daily, Weekly, Monthly) as well as Tick and 
Volume charts. It does not work (or not work reliably) on “advanced” chart types that do not contain OHLC information, 
such as Renko, Kagi and Range charts, which hide the “wicks” that contain the High/Low of each bar. The indicator hides 
itself on such chart types. It can be forced to run on them by changing the HideOnAdvCharts input, but this will not 
change the fact that these chart types do not contain the information required to reliably detect supply/demand zones. 

Terminology in this user guide 

This User Guide contains both TradeStation 9.5 and TradeStation 10 instructions and terminology. TradeStation 10 adopts 
an entirely new terminology and user interface. In particular: 

Analysis Technique is called Study in TS10. 
Format Indicator/Analysis Technique is now RightClick menu > Studies > Edit Studies > Customize in TS10 
Format Window (Charts) is now Settings > Window in TS10 
Format Page (RadarScreen) is now Settings > Page in TS10 
Show/Hide Plots (RadarScreen) is now Studies > Show/Hide Plots in TS10 

While the visual changes are significant in TS10, the underlying functionality is very much the same as version 9.5. And so 
SD Zones also works the same in both versions, as long as you know these differences in terminology. Some new features in 
TradeStation 10 are only supported in the TS10 version of SD Zones. All users have access to both versions. 

One-time activation 

SD Zones requires an active subscription in order to run. It prompts for an ACTIVATION CODE the first time you run it, 
which registers your TradeStation Customer Number to your SD Zones subscription. Enter the activation code you 
received (usually in an email with the subject SD Zones: Thank you for signing up) and click the Submit button. 

Once activated, the red activation 
notice is replaced with a cyan chart title 
and zone lines on the chart. 

Your subscription covers any number of 
TradeStation accounts, any number of 
computers, and multiple users (such as 
family members) as long as they use the 
same TradeStation login. You should 
never have to activate again, unless you 
get a new TradeStation login. 

If SD Zones is ever unable to verify your 
subscription, it will display a red 
subscription notice on charts. Please 
contact the developer or the place 
where you signed up if this should occur. 

If you see a red notice on charts saying your SD Zones version has expired, you need to update it. Install the latest version 
from the SD Zones Membership page. Older versions do not expire until well after new versions have been released. 

Note: SD Zones does NOT have access to your TradeStation login information or account numbers. The Customer Number is 
TradeStation’s official way for clients to register securely with 3rd party developers.  

https://www.thedailymarketforecast.com/products/sd-zones
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About the developer 

The software, workspaces, methods and information shared here are developed by Thomas Brandenborg, who is a veteran 
of the supply/demand technique since 2008, and an Online Trading Academy graduate taking his first class in April 2009, at 
a time when supply/demand was being taught there in its early forms. He performed extensive research into the 
methodology and its background, including studies of Richard Wyckoff (the true father of supply/demand from the early 
20th century) and thousands of hours of chart and order flow analysis. He developed his own approach to the 
supply/demand methodology, which varies somewhat from that of some other supply/demand schools. 

Thomas is an expert in supply/demand, and as a mentor and trading coach he has helped many other traders master it – 
including some who spent years and small fortunes trying to learn it elsewhere without fully succeeding.  

Thomas is a TradeStation platform specialist and EasyLanguage developer. In earlier lives he was a research analyst and 
strategy executive in an international software firm for 13 years; he founded and ran his own consultancy for 9 years with a 
team of developers specializing in graphics and systems development; and he worked as a C and Assembly language 
systems programmer. 

Thomas began his theoretical work on this software back in 2010-11 by structuring his supply/demand trading rules and 
qualification parameters with an eye towards automating them some day, fully or partially. He began developing the first 
code for SD Zones in 2017, and implemented the RadarScreen scanning feature in 2018 for his own futures day trading, in 
order to look for supply/demand setups more efficiently across many symbols and timeframes. 

He shared the first “release” version of SD Zones with clients in early 2019, and as of March 2025 has released 62 
successive versions to external users. It is mature software with regular updates. 

The software is designed and developed around the way Thomas personally uses supply/demand and his proprietary 
pattern detection methods and rules, implemented in a highly optimized fashion to allow real-time scanning of hundreds 
of RadarScreen symbol rows and real-time display of zones on charts. 

Thomas has an ambitious roadmap for further development of the software, with development milestones for at least the 
next 24 months. 

Legalese (but still important) 

Disclaimer  
The software, workspaces and documentation provided here ("the software") are meant to help find potential trades faster 
and more efficiently. You MUST know the supply/demand analysis technique in order to make meaningful use of the 
software. You always need to manually qualify any zones found. They are suggestions ONLY, and the software will often 
find zones that are not suitable for a trade. In particular do you need to always consider High Timeframe charts (HTF) to 
make sure the "Big Picture" price context and trade direction are correct for any potential entry zones found on Entry 
Timeframe charts before you consider trading those zones. As any serious trader, you need to qualify all trades according to 
a sensible checklist and trading plan. 

The developer is NOT a licensed or registered financial advisor, wealth manager, fund manager, investment adviser or 
trading adviser, and merely provides tools created for their own use, and information which they found to be working in the 
past. Under no circumstance will they or their authorized distributor be responsible for losses incurred by you, whether 
through trades chosen using these tools or for any other trades or any other losses. You alone are responsible for trades you 
choose to take. 

Terms of use 
The software, workspaces and documentation are provided to you "as is", with no specific or implied guarantees of their 
performance or fitness for any particular purpose, nor the performance of trades selected by using them. Your subscription 
grants you a limited license to use them until the stated expiration of your paid subscription period, and no longer. Your 
license is limited to "normal usage", including modifying the workspaces to your needs and customizing the software 
through its provided settings and parameters. Your license specifically prohibits unlocking, decrypting, decoding, 
disassembling or modifying the software or sharing it with any other parties. 

There is no explicit or implied guarantee that the developer will continue to provide the software in the future, nor provide it 
on the same terms. The rights, title and interest to the software and its documentation remain with the developer. 

By installing the software or loading the workspaces, you accept the disclaimer and terms as described above. 
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Quick start: Chart Analysis 

SD Zones will detect, show, update, invalidate and remove supply/demand zones on charts in real-time. 

1. In a TradeStation chart window, select Insert menu > Indicator > $SD Zones (In TS10 RightClick menu > Studies > Add 
Study > $SD Zones). Then click OK. 

2. Selecting Prompt for Format (before OK) will show the Format Indicator screen (Customize Indicator in TS10), 
including the Inputs to configure zone criteria, visual appearance and other features. 

Nearest Demand and Supply zones 
In addition to lines which show supply/demand zones on the chart, the Nearest Demand and Nearest Supply zones (if any 
exist) are displayed on the status line. In this example, they have been placed on sub-graph 2 (the lower sub-graph along 
with the Volume bars) but they can be placed on any sub-graph. See Visual chart settings below. 

Utility indicators: TickSize, ATR, ATR$, Dividends, Industry, Sector, IV, IV Plot 
In this example the sub-graph 2 status line also displays TickSize (size and dollar price of each tick), ATR (Average True 
Range) and ATR$ (ATR in dollars). These utility indicators for futures traders are included in the SD Zones package. Other 
utility indicators included for stock/options traders are Dividends, Industry, Sector, IV (Implied Volatility and IV Percentile) 
and IV Plot. The included SD Radar workspaces (see below) illustrate the intended use of these utility indicators. 

Scroll to base of a zone 
Zone lines extending past the left edge of a chart window mean the supply/demand zone was formed earlier in time. 
Ctrl + LeftClicking the line (either “Inside” or “Outside” line) will scroll the chart back to the zone so you can inspect it. 

Zone Criteria 
SD Zones detects zones according to certain criteria. It has presets for Chart confluence zones - medium lax (default); HTF 
zones - lax (all possible zones); Entry zones - medium (many zones); Entry zones - strict (fewer zones of higher 
confidence); Entry zones - extreme (very few zones); Single-bar doji zones; and Custom zone criteria (configured through 
inputs). The Chart title displays the preset currently in effect. See Zone Criteria Preset below. 

Changing Inputs 
To change the Inputs that control SD Zones’ many features, use TradeStation’s Format Indicator > Inputs tab (in TS10 
Customize Indicator). A shortcut is to double-click a zone line and click Yes, then select the Inputs tab. See Indicator 
Feature Descriptions and Input settings (complete list) below for descriptions of the various features and Inputs. 

Settings panel and ZoneMenu: Changing common settings 
Use the Settings panel or the ZoneMenu to quickly change zone detection criteria and other common settings without 
having to change their inputs. See Quick start: Settings panel and Quick start: Change on this chart only below. 

Chart title 

SUPPLY zone 

Price LABELS 

INSIDE line 
Dash-dot-dot Outside line: 
zone was “invalidated” by 
too many touches or too 
deep penetration 

DEMAND zone 

OUTSIDE line 

INSIDE line 

OUTSIDE line 

Dotted Inside line: 
zone was touched or 
"almost touched" 

2 MERGED Demand zones 

Solid Outside line: zone still valid 

2x Base HILITES  

NEAREST Demand/Supply zones 

See Visual chart 
settings below for 
descriptions of all 

chart elements 
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Quick start: RadarScreen 

When added to a RadarScreen window, SD Zones will scan in real-time for supply/demand zones in each symbol row and 
alert the user when new zones are formed or price approaches zones that might be potential trade setups.  

1. In a TradeStation RadarScreen window, select Insert menu > Indicator (in TS10 RightClick menu > Studies > Add Study > 
Indicator). Select $SD Zones (under Available) > Add (to add it to Selected). Click Move Up / Move Down (under 
Selected) to re-order the columns. Then click OK. 

2. In the RadarScreen window, add rows for each symbol you want to scan for supply/demand zones. You can add multiple 
rows of the same symbol with different Intervals (timeframes); say to scan for both 15min, 30min and 60min zones. Use 
RightClick (on a Symbol cell) > Format ‘Symbol’ to change the Interval for that row (in TS10 RightClick > Timeframe). 

Demand and Supply columns 
These columns show the “inside” price 
of demand and supply zones for each 
symbol row: The high of nearest 
demand, the low of nearest supply. 
Dash means no zones found. See “Look 
back” history (right column on this 
page) to increase the amount of history 
requested for zone scanning. 

Proximity column 
This column estimates the distance of 
each symbol to its nearest zone, 
based on current volatility and shown 
as Hours.Minutes. See Proximity: 
Distance to nearest zone below. 

Proximity alerts 
Yellow highlights (DarkBlue when using 
black backgrounds) mean price is 
“within proximity” of a zone. In this 
example, the AlertProximity threshold 
is set to 0630 (6½ hours) but can be 
changed to any number of hours and 
minutes. See Alerts and Notifications 
below. 

New Zone alerts 
Orange highlights (DarkGray when 
using black backgrounds) mean newly 
formed zones. See Alerts and 
Notifications below. 

TradeStation Alerts 
To fire TradeStation alerts when New 
Zone or Proximity alerts trigger, 
RightClick the SD Zones column header 
and select Alert > Enable Alert 
Continuously. This will enable TradeStation alerts for all symbol rows. Proximity alerts already 
highlighted will fire immediately. Subsequent alerts will fire when new zones are formed or when 
price comes “within proximity” of existing zones. See Configuring TradeStation Alerts below, 
including how to set up audible alerts and emails or text messages. 

Show matching zones on a chart 
To show the zones detected in RadarScreen on a chart, create a chart window with the same Symbol Link color and 
Interval Link color as the RadarScreen window. Add $SD Zones to the chart using the same zone criteria as in the 
RadarScreen window (same SettingsPreset Input value). Clicking any RadarScreen symbol cell will then show the zones on 
the chart. Changes made with the Settings panel can be applied to all charts and RadarScreen rows using the same 
SettingsPreset Input value. See Quick start: Settings panel below. 

Change Inputs 
To change Inputs such 
as SettingsPreset and 
AlertProximity, 
RightClick the SD 
Zones column header 
and select Format ‘SD 
Zones’ for All Symbols 
> Inputs tab (in TS10 
Studies > Edit ‘SD 
Zones’ for All 
Symbols). See Zone 
Criteria Preset below.  

ZoneMenu 
LeftClick a Demand or 
Supply cell to show 
the ZoneMenu, used 
to “invalidate” zones 
and manage alerts. 
See Quick start: 
ZoneMenu Quick 
start: ZoneMenu. 

Settings panel 
Select Settings… from 
the ZoneMenu. See 
Quick start: Settings 
panel below. 

 “Look back” history 
RightClick the SD 
Zones column header 
and select Format ‘SD 
Zones’ for All Symbols 
> General tab, then 
increase Additional 
bars to load to 
provide more historical 
data for zone scanning. 
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Quick Start: Scanner 

While SD Zones was developed mainly to facilitate real-time scanning for supply/demand zones in RadarScreen, it can also 
be used as a criterion in TradeStation Scanner, either by itself or in combination with other Scan criteria. 

1. In a TradeStation Scanner window, Insert 
a new scan (in TS10 Add), or Format an 
existing scan (in TS10 Customize) and 
proceed to the Scan Criteria tab. 

2. On the Scan Criteria tab, click Select 
Criteria > Indicator > $SD Zones, then 
click OK. 

3. On the $SD Zones criterion line, select 
Alert in the Field column, and True in 
the Operator column. This will use the 
AlertProximity feature to only include 
symbols in the scan results “within 
proximity” of a supply or demand zone. 

4. Click the + sign to show the Inputs and 
other settings for the indicator. 

5. Enter a Zone Criteria Preset in the 
SettingsPreset field. 2 (medium) or 3 
(strict) are suggested. See Zone Criteria 
Preset below.   

6. Enter a threshold in the AlertProximity 
field using TradeStation’s HHMM format. 
For example 0630 for 6½ hours (the 
length of a US stock session). This will 
include only stocks that are a day or less 
from a zone in the scan results. See 
Alerts and Notifications below.  

7. Select the Interval (timeframe) on which 
you want to scan for supply/demand 
zones. For example Daily.  

8. To change the number of bars loaded by 
TradeStation to scan for zones, enter it 
under Load additional data. Default is 
looking back 500 bars. 

9. Enter any additional scan criteria and 
click OK or Run to save or run the scan. 

Scanner vs RadarScreen 
Note that TradeStation scans do NOT work 
in real-time: they only work on the last 
closed bar, meaning yesterday’s close on a 
Daily Interval; and scans ONLY run at the 
times you select, not continuously. 

Price could have moved far away from a zone on the current bar, or it could have broken the zone already. Thus 
RadarScreen is generally preferred when looking for trade setups using supply/demand. But scans are a great tool to 
narrow a large universe of stocks down to a list which can be monitored in real-time using SD Zones in RadarScreen. 

Depending on the speed of your computer and network connection, up to 500 symbols can generally be scanned and 
monitored in real-time using SD Zones in RadarScreen. Beyond that, Scanner is preferred, since RadarScreen may run out 
of memory. 
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Quick start: Settings panel 

SD Zones contains a number of settings to control its zone detection criteria, how zones are displayed, alerts and other 
features. You change these settings using so-called TradeStation Inputs. The extensive list of Inputs is described under 
Indicator Feature Descriptions below and Input settings (complete list) towards the end of this guide. 

Using Inputs to change settings will be familiar to TradeStation users, but SD Zones also has a Settings panel, providing an 
easier way to see and change commonly used settings. Changes made with the Settings panel do not change the actual 
Input values (which only a user can do). Instead, they override the Input values. You can quickly revert to Input values. 

In charts, open Settings panel by Ctrl + RightClicking the chart background. In RadarScreen, open Settings panel by 
LeftClicking any Demand, Supply or Proxim cell and select Settings… from the ZoneMenu (see Quick start: ZoneMenu 
below). See the section Settings panel below for more information. 

Settings changes made in the Settings panel are applied to ALL charts and ALL RadarScreen rows with the same 
SettingsPreset Input value unless the Apply to all Charts and Apply to all RadarScreen rows checkboxes are toggled off.  

The title bar of the Settings panel shows the Symbol, Interval and  
window type (Chart or RadarScreen) of the selected symbol. 

Zone detection tab: Zone criteria 
and other settings that affect 
zone detection. 

See Zone Criteria Preset, Zone 
types to show and Zone height 
rule below. (Click these links to 
jump there.)  
 

See Touches and “almost 
touches” and Merged zones 
below. 

See Ignore zones formed 
overnight below. 

See Proximity: Distance to 
nearest zone and Alerts and 
Notifications below. 

Check to apply settings to ALL 
charts/RadarScreen rows with 
same SettingsPreset Input value. 
Uncheck to apply settings to THIS 
chart/RadarScreen row only. 

Click the Apply button to update 
with the selected settings. 
Changes will NOT take affect until 
clicking this. 
 

Note: the Only within this workspace feature only works in TradeStation 10. In TradeStation 9.5 a name must be entered in 
the ShareWorkspaceName input. Otherwise settings will be applied In ALL open workspaces. See the section Settings 
panel below for more information. 

Click the 
Inp (Input) 
button for 
each setting 
to revert just 
that setting 
to its Input 
value 

Visual settings 
tab: See Visual 
chart settings 
below. 

About tab: 
shows SD 
Zones Version 
and other 
information 

Select if settings 
should be 
applied only 
within THIS 
workspace or 
in ALL open 
workspaces 

Click the 
Reset ALL 
button to 
revert ALL 
settings to 
their Input 
values 
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Quick start: ZoneMenu 

SD Zones allows various manual actions to be taken on individual zones through their ZoneMenu. This pop-up menu is 
shown by RightClicking a zone line in a chart or by LeftClicking a Demand or Supply cell in RadarScreen. Unfortunately 
TradeStation does not allow studies to use RightClick in RadarScreen.  The ZoneMenu is slightly different depending on 
whether shown from charts or from RadarScreen. See the two screenshots below. 

Change on this chart only shows a fly-out menu offering quick and 
easy changing of SettingsPreset and toggling of other common 
zone criteria and visual settings instead of using the Settings panel 
(see above). Use it to review how different settings affect zones 
drawn on the chart. Modified settings can be quickly Reset to Input 
values after review. 

Invalidate this zone marks a zone “not to be trusted” as an entry 
zone. Invalidated zones are removed from the RadarScreen 
“candidate list” and shown on charts with a dash-dot-dot outside 
line. See Invalidating and restoring zones below on this page.  

Restore this zone restores a previously Invalidated zone. If the 
ZoneMenu is shown from RadarScreen (lower screenshot), or if 
invalidated zones are hidden on charts, the menu will instead show 
a command to Restore the last invalidated zone of the same zone 
type as the one selected (Demand or Supply). 

Restore all … zones: These commands restore ALL previously 
invalidated zones in the current symbol and interval, the current 
symbol or in ALL symbols across all charts and RadarScreen rows. 

Apply invalidate/restore to shows a fly-out menu used to toggle 
whether changes should Apply to all Charts and/or Apply to all 
RadarScreen rows, and whether to apply them Only within this 
workspace or in ALL open workspaces. Changes are only applied to 
other charts/RadarScreen rows using the same SettingsPreset 
input value. 

Clear this New Zone alert clears the orange RadarScreen 
notification highlight for a newly formed zone (dark gray when 
using black backgrounds). See Alerts and Notifications below. 

Alerts (ALL RadarScreen rows) shows a fly-out menu offering alert 
commands and settings applying to ALL RadarScreen rows. See 
Alerts and Notifications below. 

Settings… opens the Settings panel for the selected chart or RadarScreen row. See Quick start: Settings panel above. 

Invalidating and restoring zones 
SD Zones ALWAYS invalidates a zone when price has touched it too many times OR penetrated too deeply into it, causing it 
to be removed in RadarScreen and shown with a dash-dot-dot outside line on charts. Such zones should generally not be 
trusted as entry zones since they are no longer “fresh”. See Line styles and zone “freshness” below. 

The ZoneMenu allows zones which have NOT already been invalidated by the indicator to be manually invalidated by the 
user. This lets you “take them off the candidate list” in RadarScreen, and see in charts that they shouldn’t be trusted (like 
other invalidated zones). They can be hidden in charts altogether by toggling ZoneMenu > Change on this chart only > 
Show invalidated zones or by disabling Invalidated zones using the Settings panel. 

Zones which have been manually invalidated can be restored using the ZoneMenu in case you want to give them a second 
look. Zones which were invalidated by the indicator due to too many touches or too deep penetration CANNOT be 
manually restored. Only zones which were manually invalidated can be manually restored. 

In charts, open the ZoneMenu by RightClicking a 
zone line (inside or outside line works the same). 

 

In RadarScreen, open the ZoneMenu by 
LeftClicking a Demand or Supply cell.  
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Quick start: Change on this chart only 

When analyzing charts, whether reviewing the quality of an a potential zone on an Entry chart, determining the “preferred 
trade direction” on a High-Timeframe chart (HTF), or any number of other tasks, it is often useful to temporarily change 
some SD Zones settings to see “what if”.  

The Change on this chart only feature on the ZoneMenu (see above) allows you to toggle zone criteria and other settings 
with just a few mouse clicks. AND it lets you reset those settings back to Input values just as quickly. 

RightClick any zone line created by SD Zones to show the ZoneMenu. If no zone lines are visible on the chart, RightClick 
the Chart Title in the top-left corner of the chart. One the ZoneMenu, select the Change on this chart only fly-out menu. 

Some example scenarios where you will find Change on this chart only very useful: 

• Temporarily change an HTF chart to Entry zones (medium or strict) to see if an HTF zone is “Entry quality”, thus making 
it legit for countertrend trades. See Supply/Demand lessons below. 

• Temporarily change an Entry chart to Entry zones - extreme to check if the structural quality of a zone is particularly 
high, thus allowing a bit more tolerance of other aspects of the setup (HTF direction, location etc). 

• Temporarily change an Entry chart to Chart confluence - medium lax or HTF zones - lax to check for opposing zones 
which might get in the way of a trade. See Look for the EASY money below. 

• Temporarily Show RBD and DBR zone types (the “inauthentic” ones) when using Entry zone presets (which default to 
only show DBD and RBR zones, the “authentic” ones). Or vice versa when using Chart confluence preset (which defaults 
to show ALL zone types). 

• Temporarily change any chart to draw zones wick-to-wick, as recommended on very high quality, very tight Entry zones; 
or to see if price has gotten precariously close to the wick-to-wick high/low of an HTF zone. 

• Temporarily disable Merge close or overlapping zones to see the individual zones in a “stack” of merged zones. 

• Temporarily disable Show invalidated zones to only see zones on a chart that are still fresh and unspoiled. 

• Enable Proximity or New Zone alerts on charts, so as to fire TradeStation alerts when NOT using RadarScreen. Disabling 
Show invalidated zones is recommended when using Proximity Alerts in charts. 

• Reset ALL of the above settings back to Input values after messing around. 

Changes made using Change on this chart only do not change the actual Input values (which only a user can do). They use 
the same settings “overrides” as the Settings panel (see the section Settings panel below). You will see the changes 
reflected in Settings panel and vice versa. Change on this chart only is merely an even faster way to change settings when 
you only want to change them on the current chart, and want to easily revert the changes after you are done. 

SettingsPreset: See Zone 
Criteria Preset below 
(click the link). 
 

See Zone types to show 
below. 

See Zone height rule: 
Wick-to-body or wick-to-
wick below. 

See Merged zones below. 

 

See Line styles and zone 
“freshness” below. 

See Alerts and 
Notifications below. 

Reset ALL of the above 
settings to Input values. 
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SD Radar workspaces 

SD Zones comes with a collection of ready-to-use workspaces for stock/options and futures trading, dramatically speeding 
up the process of finding and qualifying potential trades using the Supply/Demand technique. 

Each workspace contains a RadarScreen window with one or more pages (tabs) containing symbol rows, each row showing 
the nearest demand and supply zones for that symbol and interval and highlighting its Demand or Supply cell in real-time 
if price approaches a potentially tradable Entry zone or if a new zone forms. 

Chart windows are linked to the symbol rows in RadarScreen to show the detected zones. Each workspace contains Entry 
timeframe charts, showing the zones found in RadarScreen; Low timeframe charts (LTF), to look “inside” the Entry zone; 
and High Timeframe charts (HTF) to assess “Big Picture” price context and determine preferred trade direction. 

This allows you to jump directly to symbol rows in RadarScreen with highlighted Demand or Supply zones, and evaluate on 
the charts whether there is a potential trade setup. If so, you can further qualify and analyze the setup according to your 
trading rules. If not, you can move on to the next highlighted symbol row in RadarScreen – or wait for TradeStation to alert 
you (assuming TradeStation Alerts are enabled – See Alerts and Notifications below). 

The descriptions and screenshots in this section further explain the features of the SD Radar workspaces. 

SD Radar workspaces Scan for potential Entry zones in RadarScreen and show the zones on Entry charts alongside High 
Timeframe (HTF) charts and Low-Timeframe (LTF) charts to help the trader review and qualify them as potential trade 
setups. This example shows the SD Radar Stocks Daily workspace. Other Stocks workspaces have similar layouts, but with 
different timeframes (intervals). SD Radar Futures workspaces have a slightly different layout. See SD Radar Stocks 
workspaces and SD Radar Futures workspaces below. 

RADARSCREEN scanning 
in real-time for zones, 
highlighting newly 
formed zones and any 
that are close to current 
price 

Click a Symbol cell to 
show zones on charts 

ENTRY CHART showing 
the potential Entry zone 
found in RadarScreen 
along with other zones 

LOW TIMEFRAME chart (LTF) 
looking “inside” Entry zones  
to verify their structure and 
fine-tune the exact high/low 

HIGH TIMEFRAME chart (HTF) to 
assess “Big picture” price context and 
determine preferred trade direction 

NEXT-HIGHER Timeframe 
chart (Next-HTF) to gauge 
“room to move” of trends on 
the HTF chart 
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Workspace names and categories 

When downloading the SD Radar workspaces, you will find them grouped into folders and named according to categories: 

Black or white background color 
The workspaces come in black and white variants to accommodate different trader preferences. 

Stocks or Futures 
SD Radar Stocks workspaces for stock and options trading, containing the S&P500 list of stock symbols plus a list of 80 
ETFs. They come in Day, Swing, Daily and Weekly variants (see below). 

SD Radar Futures workspaces for futures trading, containing a list of 18 equity index, interest rate, commodity and 
currency futures. They come in Day, Ticks, Swing, and XL Swing variants (see below).  

Trading style/timeframe 
Futures Day workspaces scan for day trades in RadarScreen on 3, 5, 10, 15, 20 and 30 min intervals, with matching Entry 
charts. Stocks Day workspaces scan for 10 min trades in RadarScreen, but can be changed to scan for other intervals. 

Futures Ticks workspaces scan in RadarScreen on tick zones with intervals adapted to each futures contract. 

Futures Swing workspaces scan for swing trades in RadarScreen on 15, 20, 30, 60, 120 and 240 min intervals, with 
matching Entry charts. Stocks Swing workspaces scan for 60 min in RadarScreen, but can be changed to scan for other 
intervals. 

XL Swing workspaces scan for high-interval swing trades in RadarScreen on 60, 120, 180, 240, 360, and 480 min intervals, 
with matching Entry charts.  

Daily and Weekly workspaces (Stocks only) scan for stock/options position trades in RadarScreen using Daily/Weekly 
intervals, with matching Entry charts. 

Futures workspaces scan for multiple intervals simultaneously in RadarScreen. Click the Symbol cell of a row in 
RadarScreen to show that symbol and interval in the top-left Entry chart, which is interval-linked to RadarScreen. 

Stocks workspaces only scan for a single interval due to the large number of symbols in the stocks list. Change the 
RadarScreen interval for All Symbols in the Stocks workspaces to scan on different intervals. The interval of the main Entry 
chart is linked to the RadarScreen interval. 

HTF Overlay workspaces 
The Futures workspaces come in HTF Overlay variants, which show magenta HTF zones overlaying the cyan Entry zones 
on a single large Entry chart instead of multiple smaller Entry charts. In other workspaces, charts with cyan zone lines are 
Entry charts while charts with magenta zone lines are High Timeframe charts (HTF). The Chart title in the top-left corner 
of each chart also shows the colors of Entry and HTF zones, respectively. 

Zone Criteria in SD Radar workspaces 

All minute based SD Radar workspaces (Day, Swing, XL Swing) use the Strict Zone Criteria Preset by default 
(SettingsPreset=3). Ticks workspaces use the Ticks preset (SettingsPreset=5). Daily and Weekly workspaces use the 
Medium preset (SettingsPreset=2). See Zone Criteria Preset below. 

Strict preset generally finds zones of higher confidence. Medium finds more potential entry zones from which to choose, 
including some (sometimes many) that may not qualify. Extreme finds very few zones, generally with excellent structure, 
but will often overlook some that turn out to be great trades, which would have been found with Strict or Medium. The 
Ticks preset finds fewer zones than Strict and is specifically tuned for tick zones.  

The Settings panel can be used to change the Zone Criteria Preset in a given workspace with just a few mouse clicks, along 
with several other Zone detection and Visual settings. See Quick start: Settings panel above. 

Screen size and workspace layout 

SD Radar workspaces were designed for a Full-HD monitor (1920x1080 resolution) using Windows 100% Scale setting. 
Since monitors come in a range of sizes, from small 10” notebooks/tablets to 65” or larger TVs, AND in a wide range of 
resolutions, from 1280x720 (HD) up to 3840x2160 (UHD/4K), people use different Windows scale settings to ensure that 
text is readable (set in Windows under Display settings > Scale & layout). 

Consequently no workspace layout will fit all screens, and you may have to adjust the layout of the RadarScreen and chart 
windows in the SD Radar workspaces when you first start using them, EITHER to make sure you can see all the RadarScreen 
columns (in cases of resolutions lower than 1920x1080 or Windows scaling higher than 100%), OR to utilize any unused 
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blank space on the right side of the RadarScreen screen (in cases of resolutions higher than 1920x1080). The goal is always 
to provide as much chart space as possible while keeping all RadarScreen columns fully visible. 

Once you have adjusted the workspaces, you can save them under a new name, OR just overwrite the original workspace 
files, since you can always download them again. 

 

SD Radar Stocks workspaces 

The Stocks workspaces all share the same basic layout, with a RadarScreen window on the right side, and four charts 
showing the Entry timeframe, Low Timeframe (LTF), High Timeframe (HTF) and Next-higher timeframe (Next-HTF). The 
main difference between the Stocks workspaces is the timeframe (interval) used in RadarScreen and the different charts.  

SD Radar Stocks workspaces (Daily in this screenshot) scan for potential entry zones in hundreds of stock/ETF symbols and 
highlight/alert Demand and Supply cells where price is close to a zone (Proximity alert) or when new zones are formed 
(New Zone alert). Zoom in to read descriptions of different screen elements. 

Additional stock/options info shown 
S&P500 4-week Relative Strength - RadarScreen column. Prefer buying demand zones in over-performing stocks, shorting 
supply zones in underperforming stocks. 

Beta - RadarScreen column. Choose high beta stocks for higher potential profit and more risk. 

Implied Volatile (IV) & IV Percentile - RadarScreen columns in Daily/Weekly workspaces, status line on Daily charts. IV 
Pctile changes color when IV is low, medium or high relative to the last year. Prefer long options premium on low IV Pctile 
(e.g. long puts/calls, debit spreads); prefer short options premium on high IV Pctile (e.g. naked puts/calls, credit spreads); 
prefer IV neutral strategies on medium IV Pctile (e.g. ratio spreads). 

Note: TradeStation only provides Implied Volatility data on Daily and Weekly timeframes, which is why it is only shown in 
RadarScreen in the Daily and Weekly workspaces. It is shown in the Daily chart as well in ALL the Stocks workspaces. 

Implied Volatility Plot (historical IV) - plot on Daily charts. IV is more likely to fall when it is near highs, and rise when it is 
near lows. This can dramatically affect the extrinsic value of an options position, particularly around events like earnings. 

Sector & Industry - status line on 60 min chart in Day workspace; status line on Weekly chart in other Stocks workspaces. 
Shows Reuters classification (which is what TradeStation offers). The stock list in RadarScreen is grouped by the same 
sectors, with each sector heading listing the corresponding S&P sector and SPDR Sector ETF in parentheses (where one 
exists), such as Consumer Cyclical (Consumer Discretionary / XLY). Use this to compare the stock to its Sector ETF on the 

This workspace scans for 
Entry zones on DAILY charts Chart title shows that 

MEDIUM zone criteria are 
in effect (many zones)  

Use Settings panel to 
change zone criteria 

Demand/Supply columns 
show NEAREST zone for each 
symbol row 

PROXIM column shows 
distance to nearest zone as 
approx HH.MM 

Highlighted zones are within 
distance from price set by 
AlertProximity (as HHMM) 

 

ENTRY CHART shows 
zones of symbol row 

clicked in RadarScreen 

Implied Volatility / IV 
Percentile of each stock 

High Timeframe charts 
(HTF) showing HTF zones 

RightClick SD Zones column 
header to set Inputs and 
Alerts for ALL symbol rows 

LOW TIMEFRAME 
chart (LTF) looks 
“inside” the Entry zone 

 

Sector & Industry of stock 
(reported by TradeStation) 

Dividends & ExDiv date 
turns red 14 days before 
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ETF page. Look for correlation between the stock, sector and broad market in your trades. Prefer buying demand zones in 
strong sectors, shorting supply zones in weak sectors, ideally when the sectors are ALSO approaching zones of the same 
type (demand or supply). 

Dividends and ExDiv date - on status line of 60 min or Weekly charts. Turns red 14 days before ExDiv date. Avoid most 
options trades when approaching ExDiv date to avoid premature assignment and other gotcha situations. 

Note: In addition to the above, you also want to consider average stock volume, options open interest, bid-ask spread 
and available options expirations before entering options trades. Supply/demand and options is a fantastic match, but 
qualified trades require far more than just a good Entry zone. The Stocks workspaces are meant to help with that process. 

Stocks workspaces and download time 
Between the S&P500 and the ETF RadarScreen pages (tabs), the Stocks workspaces contain almost 600 symbol rows. 
Downloading all the data needed for these rows can take considerable time for TradeStation, depending on the computer, 
network connection, and the current load on TradeStation servers (evenings US Eastern time are generally worst). The 
Stocks Swing workspace can be particularly slow, as it needs over 1GB of intraday market data the first time it is loaded. 

It is HIGHLY recommended that you give TradeStation all the time it needs to complete these downloads: Open View menu 
> Download Scheduler (in TS10 Messages > Download Scheduler) and wait for any tasks listed on the Scheduled Items 
tab to complete. Trying to perform ANY tasks in TradeStation while it is still downloading can sometimes cause the platform 
to hang or become unstable. 

Note: If any items scheduled for download say Off peak instead of ASAP in the Priority column, that means TradeStation is 
set to NOT download data immediately. In that case, or if the data download does not make progress, use the steps Fixing 
TradeStation Download Scheduling below. Also check the section Speeding up TradeStation below. 

Once all required data is downloaded, the SD Zones indicator takes only a few seconds to calculate all the symbol rows, and 
it does NOT place a heavy load on TradeStation while it is running. Subsequent loading of the Stocks workspaces will be 
much faster since most of the required data is already saved in TradeStation’s cache. 

Note: Only open ONE SD Radar Stocks workspace at a time. RadarScreen only has limited memory capacity covering ALL 
RadarScreen windows in ALL workspaces. Multiple open Stocks workspaces might exhaust it, even on a fast computer with 
lots of memory. 

Customizing the stock list 
While the S&P500 list of stocks is a reasonable starting point, you may not want to trade them all. Trimming the list will 
speed up loading the workspaces. You can remove select stocks or entire sectors from the list.  

You can also create an entirely new custom list using TradeStation scanner. The Scan Criteria shown below provide a good 
starting point, using Market Cap, Stock price, Average Volume, Open Interest and Options volume. It also includes a 
calculation to factor in Open Interest relative to the price of the stock, since the criterion for “high” Open Interest will be 
vastly different for a $20 stock than for a $2000 stock.  

 

 

 

 

 

TradeStation Scan Criteria 
which can be used to create a 
custom stock list for the SD 
Radar Stocks workspaces 
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SD Radar Futures workspaces 

The Futures workspaces all share the same basic layout, with a RadarScreen window on the right side, several Entry 
Timeframe charts in the center and two High Timeframe (HTF) charts on the left side. The main difference between the 
Futures workspaces is the intervals (timeframes) used in RadarScreen and the different charts. 

Since the Futures workspaces scan for fewer symbols than the Stocks workspaces, they can scan each symbol on multiple 
Entry intervals in RadarScreen (using symbol rows with different intervals) without exhausting RadarScreen’s capacity and 
memory limits. As delivered, the Futures workspaces contain 18 different equity Index, interest rate, commodity and 
currency futures symbols. Day workspaces scan for 3, 5, 10, 15, 20 and 30 min Entry zones. Swing workspaces scan for 15, 
20, 30, 60, 120 and 240 min Entry zones. XL Swing workspaces scan for 60, 120, 180, 240, 360 and 480 min Entry zones. 

You can of course add other futures symbols and other intervals, or remove some, to fit your trading interest. 

SD Radar Futures workspaces (Swing in this screenshot) scan for potential entry zones on multiple intervals of each 
Futures symbol, and highlight/alert where price is close to a zone. Zoom in to read descriptions of different screen elements. 

Additional futures info shown 
Tick size & Tick value - status line on each Entry chart. Shows the “minimum move” (tick size) of the futures contract (e.g. 
0.25 for @ES, 0.01 for @CL, 0.1 for @GC, 0.5/32 for @TY) and the dollar value of each tick (e.g. $12.50 for @ES, $10 for 
@CL and @GC, $15.63 for @TY). Use this to calculate the risk-per-contract of a given zone, based on its height and your 
desired stop buffer, or the dollar value of any other price move. 

ATR & ATR$ - status line on each Entry chart. Shows the average true range as of the last completed bar and the 
corresponding dollar value. Uses 14 periods by default to calculate ATR, but can be changed through the inputs for these 
indicators. Use this to assess whether the height of a zone and your stop buffer are realistic compared to current 
volatility. SD Zones adjusts the height of Entry zones to at least 50% of ATR (at the time of its Leg-out) to avoid trading 
unrealistically narrow zones. Always apply your own common sense as well. 

Custom Continuous Futures symbols 
The Futures workspaces use TradeStation’s Custom Continuous Futures feature. Hence symbols such as @ES=105XN 
instead of just @ES. This is necessary in supply/demand analysis to avoid prices in prior contract months from being 
shifted up/down to smooth out rollover gaps, as TradeStation otherwise does with the standard symbols @ES, @CL etc. 
The provided futures symbols and their specific rollover triggers were found to generally capture the most volume around 
rollovers (a rollover trigger is the string following the “=“ in TradeStation Custom Futures symbols, such as @ES=105XN). 
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As always, you need to add the front month code to a given futures symbol in order to trade it (such as @ESM23=105XN 
or just @ESM23). If you are unsure of the front month of a given contract, an easy way to add it is Format Symbol (double 
click bars on chart) > Settings tab > Symbol Lookup > Custom Futures tab > Use this symbol for trading. 

Futures HTF Overlay workspaces 
The Futures workspaces come in so-called HTF Overlay variants, with HTF zones from the HTF chart superimposed 
(overlaid) on the Entry chart. This makes it easy for users who are new to supply/demand, or not experienced matching up 
separate Entry and HTF charts, to evaluate Entry zones in relation to the HTF zones and determine preferred trade 
direction. See HTF zones overlaid on Entry charts and Entry zones vs High Timeframe zones below. 

SD Radar Futures (HTF Overlay) workspaces use a single large Entry chart to show both Entry zones and HTF zones. Its 
Symbol and interval (timeframe) are linked to the symbol row selected in RadarScreen. A hidden High Timeframe symbol 
looks for HTF zones, which are shown overlaid on the Entry chart. Zoom in to read descriptions of different screen elements. 

Futures scalping workspace 
For very active traders, TradeStation’s unique volume charts combined with supply/demand zones can be a great tool for 
futures scalping. To this end a Futures Scalping workspace is included in the Extras folder. As with other Futures 
workspaces, it is delivered using Strict zone criteria (SettingsPreset=3), but can be easily changed with the Settings panel. 
See Zone Criteria Preset below and Quick start: Settings panel above. 

The scalping workspace contains four volume based Entry charts (top row) to monitor the @ES, @NQ, @YM and @RTY 
Index futures, and linked HTF charts (bottom row). They can be changed to any symbols desired. The HTF charts default to 
10 min, but can be changed as well. The Entry charts use different intervals (share/volume settings) to reflect the volume 
of each index. For example @ES has vastly more volume than @YM. Volume in each index will vary on any given day, and 
the share/volume settings should be adjusted to match. A share/volume setting that keeps ATR$ near $100 often works 
well (displayed in the lower status line) although this changes constantly with market volatility. 

To some traders, scalping means capturing tiny price moves (as small as 1-2 ticks) often with an upside-down reward/risk. 
Scalps with supply/demand and volume charts are “real trades”, using HTF charts to determine preferred direction, and 
using qualified entry zones and opposing zones on the Entry charts to select entries, targets and stops, and to manage 
trades. It is often advisable to take partial profits at 1:1 reward/risk and move stops to breakeven. 

Note: This form of trading requires expert mastery of the Supply/Demand technique as well the TradeStation platform. As 
with ANY trades found using the Zones and its utility indicators and accompanying workspaces, the responsibility is entirely 
on YOU, the trader, to choose and qualify setups and to execute and manage trades. The tools are designed to help find 
potential trade setups, and nothing more. 
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How to use the SD Radar workspaces 

The purpose of the SD Radar workspaces is to have the SD Zones indicator scan in real-time for supply/demand zones on a 
list of RadarScreen symbol rows and notify the user when one is approaching a potential entry zone OR when a new zone 
forms. See Alerts and Notifications below for how to control this scanning and the notification. 

Once SD Zones has notified you of a symbol with a potential entry zone (either by highlighting the Demand or Supply cell 
in RadarScreen or with a TradeStation Alert) you click the corresponding Symbol cell to display the symbol in the linked 
chart windows. 

Your job as a trader is now to qualify (or eliminate) the detected entry zone as a potential trade setup. Use the following 
general steps:  

1. Review the quality of the suggested zone on the corresponding Entry timeframe chart. Look inside it using the LTF chart 
to inspect its structure and fine tune its exact height. You can also just change the Entry chart to 1/2 the Entry interval. 

2. Review the HTF (High Timeframe) charts for “Big Picture” price context and preferred trade direction. Expect price to 
swing between opposing HTF zones and prefer entry zones in that direction (Demand zones on your Entry chart when 
HTF direction is UP, Supply zones when HTF direction is DOWN). See Entry zones vs High Timeframe zones below. 

3. Consider distance from the entry zone to “opposing zones” on both Entry chart and HTF charts to make sure there is 
plenty of profit margin. Look for the “easy money”, with no (or only few) chart features in the way of your trade.  

4. Match the setup to the rules in your Trading Plan and your checklist. 

All this requires understanding the Supply/Demand technique as well as general trading skills. Teaching of those is beyond 
this User Guide, although some tips are included under Supply/Demand lessons below. 

Use RadarScreen as your candidate list 
The Demand and Supply cells in RadarScreen are meant to be your trade setup candidate list. For each symbol and 
interval, they show the nearest zones, closest to current price given the zone criteria currently in effect (Medium, Strict or 
Extreme – see Zone Criteria Preset below).  

The Settings panel can be used to change the zone criteria in a given workspace with just a few mouse clicks. See Quick 
start: ZoneMenu above. If a preset (say Strict) finds too many candidates at a given time, switch to a higher preset (say 
Extreme); if it finds too few candidates, switch to a lower preset (say Medium).  

The Proxim column in RadarScreen estimates how soon price might reach a zone, expressed in hours and minutes. When 
that value comes within the threshold specified by the AlertProximity Input, the corresponding Demand or Supply cell is 
highlighted (yellow or blue depending on background color). AlertProximity can also be set in the Settings panel under 
Alert when proximity to zone is within [HHMM]. Enter a number using TradeStation’s HHMM format, e.g. 0030 (30 mins) 
for day trading, as in the Day workspaces; or 0630 (6½ hours, one stock session) as in the Stocks Daily workspace. But you 
can adjust it to increase or decrease the number of highlighted zones at a given time. 

Spend your time smartly 
When looking for trades, start with zones of higher quality, close enough to current price that they are likely to meet entry  
(to fill). If you have too many candidates, you can tighten the net with stricter zone criteria OR lower AlertProximity. If you 
run out of candidates, you can widen your net with more lax zone criteria OR higher AlertProximity. 

You will find that market dynamics dramatically impact how many quality zones are available on a given day or at a given 
time: On days and times with high institutional market participation, there will be plenty of zones from which to choose. 
On days/times with mostly retail participation, there will be only few zones. This is to be EXPECTED and should be 
RESPECTED: Don’t force trades when there are only mediocre setups! 

Invalidating and restoring zones 
If a zone shown in RadarScreen doesn’t fit your rules, it can be “invalidated” using the ZoneMenu shown when clicking a 
Demand or Supply cell in RadarScreen. That will “take it off the list” and update its lines on the charts to show the zone as  
invalidated. You can then proceed with the next highlighted zone in RadarScreen.  

This feature helps using RadarScreen as your real-time trade candidate list: As you work your way down the list of high-
lighted zones, invalidating ones you don’t want, you know that any new highlighted Demand or Supply cells are EITHER 
newly formed zones OR price approaching a zone you didn’t already review. Remember, SD Zones works in real-time! 

If you save the SD Radar workspace, any invalidated zones will be saved with it. If you don’t want that, you can either NOT 
save the workspace, or you can select Restore all zones in all symbols from the ZoneMenu before saving. 

See Quick start: ZoneMenu above. 
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Indicator Feature Descriptions 

SD Zones has a very rich feature set to accommodate a broad spectrum of different trading styles and different ways to use 
the supply/demand technique. These features are accessed through a number of settings (so-called Inputs in TradeStation) 
which control the criteria it uses to scan for supply/demand zones, visual settings for how they are displayed on charts and 
in RadarScreen, how and when it notifies you of newly formed zones or when price approaches an existing zone that might 
be a potential trade. You change these Inputs using TradeStation’s Format Indicator > Inputs tab (in TS10 Customize 
Indicator > Inputs tab). 

In charts use RightClick menu > Analysis Techniques > SD Zones > Format > Inputs tab (in TS10 RightClick menu > 
Studies > Edit Studies > SD Zones > Customize > Inputs tab). A shortcut is to double-click one of the lines created by SD 
Zones and click Yes, then select the Inputs tab if it isn't already shown. Note that this will change Inputs ONLY for that 
chart window. 

In RadarScreen RightClick the SD Zones column header and select Format ‘SD Zones’ for All Symbols (in TS 10 RightClick 
menu > Studies > Edit ‘SD Zones’ for All Symbols). You can also format just a single row in RadarScreen, but usually you 
want to format all symbol rows. 

Instead of using inputs, many frequently used features can be changed using the Settings panel. See Quick start: Settings 
panel above for a screenshot of the Settings panel and how to use it. 

See Input settings (complete list) towards the end of this guide for a list of ALL the Input settings. 

Zone Criteria Preset 

The first Input is SettingsPreset, which provides a single setting to control all the criteria for what type and quality of zones 
the indicator detects. It provides six different presets (0, 1, 2, 3, 4 or 5) with varying “strictness” of zone criteria; or you can 
enter 99 to program your own custom values of the individual Inputs that affect zone criteria.  

Even if you do not learn any of SD Zones’ features, you definitely want to know SettingsPreset and how and when and why 
to change it. 

SettingsPreset accepts the following values: 

0: Chart confluence (medium lax) (default) - finds zones suitable as chart confluence with other indicators or signals 
1: HTF zones (lax) - finds any zone, as typically used for High Timeframe charts (HTF) and “opposing zones” 
2: Entry zones (medium) - finds zones suitable as Entry zones, including many that may not qualify 
3: Entry zones (strict) - finds only Entry zones of higher confidence, but may overlook some good zones 
4: Entry zones (extreme) - finds only Entry zones of even higher confidence, but overlooks many good zones 
5: Entry zones (ticks) - tuned specifically for tick-based charts, finds fewer zones than Preset3 
6: Single-bar doji zones - finds only Entry zones with bases consisting of a single doji candle 
99: Custom zone criteria - no preset, use Custom Zone Criteria inputs to program zone detection 

Preset0 (Chart confluence - medium lax) 
For general chart use and learning how SD Zones works. Consider zones only in confluence with other indicators or trade 
signals since Preset0 will find many zones that may not be suitable as Entry zones on their own. It includes both “authentic” 
zones (Drop-Base-Drop and Rally-Base-Rally) and “inauthentic” zones (Drop-Base-Rally and Rally-Base-Drop). The zones 
MUST be visually inspected to verify their structure and ensure they are still “fresh”, meaning price hasn’t revisited a zone 
since it was formed, or if it has, not very often and not very deep into the zone. See Line styles and zone “freshness” 
below. This is the default preset when first adding the SD Zones indicator to a new chart or RadarScreen. 

Preset1 (HTF zones - lax) 
Will find lots of zones, often merged (combined) when overlapping or close to each other. See Merged zones below. It 
includes “twilight zones” that may or may not be zones, but which we don’t want to overlook, since they might still cause a 
reaction in price, particularly on lower timeframes when the zone is found on a higher timeframe. It is applicable mainly to 
HTF charts, used to assess “Big Picture” price context and determine preferred trade direction. HTF Zones are NOT to be 
considered as entry zones. Expect price to swing between HTF zones on HTF charts, and prefer trades on Entry charts in 
the direction of these moves. Only trade AGAINST this direction when price comes inside HTF zones of “Entry quality” that 
are still “fresh”. See Entry zones vs High Timeframe zones and Line styles and zone “freshness” below. 

Preset2/3/4/5 (Entry zones - medium/strict/extreme/ticks) 
Used to scan for potential Entry zones in RadarScreen and show the results on charts. These presets filter out most of the 
lower probability zones found by Preset0 and Preset1 to let you focus on reviewing fewer zones of higher probability found 
across many RadarScreen symbol rows. These presets show only “authentic zones” (Drop-Base-Drop and Rally-Base-Rally) 
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which are usually higher probability than “inauthentic” ones (Drop-Base-Rally and Rally-Base-Drop). Start with Preset3 
(strict), then move on to Preset2 (medium) only if you run out of candidates; or move to Preset4 (extreme) if you have too 
many candidates and want to start with the highest probability ones. Preset5 (ticks) is tuned for tick-based charts. 

Preset6 (Single-bar doji zones) 
Used by traders who specialize in zones whose bases consist of a single doji bar (generally considered very “basey”) with 
leg-in and leg-out being extra “leggy”. It finds only very few zones, but given the right location on the chart, these zones 
can have very high probability. 

See Choosing a SettingsPreset below for further advice on choosing Presets. 

Preset99 (Custom zone criteria) 
No preset zone criteria will be loaded. Zone detection is programmed by the following Custom Zone Criteria Inputs: 

Custom Zone Criteria Inputs 
MinZoneBars ( 1 ) min number of bars in base 
MaxZoneBars ( 8 ) max number of bars in base 
MinZoneHeightSkipTicks ( 3 ) min height of base in ticks - or skip zone 
MinZoneHeightSkipATR ( 0.1 ) min height of base relative to ATR - or skip zone 
MinZoneHeightAdjATR ( 0.5 ) min height of base relative to ATR - or adjust height 
ATRLength ( 36 ) number of bars for ATR calculation 
MinLegoutSize ( 1.25 ) min size of Leg-out (relative to height of base)  
MinLeginSize ( 0.90 ) min size of Leg-in (relative to height of base)  
MinBaseBarScore ( 0 ) min bar score for Base bars 
HiConfBaseBarScore ( -6 ) high confidence score for Base bars 
MinLegBarScore ( 2 ) min bar score for Leg bars 
HiConfLegBarScore ( 2 ) high confidence score for leg bars 
MinLegBar2Score ( 1 ) min score for following Leg bars 
MaxLegoutBarBreakATR ( 0.1 ) max above/below base on Leg-out bar relative to ATR - or skip zone 
MaxTouchBarsInvalid ( 6 ) max bars touching into zone before it's invalidated 
MaxTouchDepthInvalid ( 0.5 ) how deep into zone before it's invalidated (relative to base height)  
MinLegoutMove ( 0.75 ) min size of move from base for first Leg bar (relative to base height)  
MinLegBarMoveATR ( 1.00 ) min bar move to continue a leg (relative to ATR) 

You can change these Inputs individually, but you have to enter SettingsPreset=99 in order for them to take effect. When 
SettingsPreset is any value OTHER than 99, these inputs are ignored, since Zone Criteria are controlled by the Preset. 

Note: Regardless of which Preset you use, or if you use your own Custom Zone Criteria, you always need to manually qualify 
the zones found by the SD Zones indicator. They are suggestions ONLY, and SD Zones will often find zones that are not 
suitable for a trade. In particular do you need to always consider High Timeframe charts (HTF) to make sure the “Big 
Picture” price context and preferred trade direction are correct for any potential entry zones found on Entry Timeframe 
charts before you consider trading them. 

Other zone criteria Inputs 
The following Inputs override the SettingsPreset, allowing it to be customized regardless of the selected Preset.  

ZoneTypesToShow ( 2 ) 0=Show ALL zone types  
1=Show DBD & RBR only  
2=Use SettingsPreset, if Preset99 show all zones 

ZoneHeightRule ( 0 ) 1=Qualify and draw zones Wick-to-Body (find more zones)  
2=Qualify and draw zones Wick-to-Wick (find fewer zones)  
3=Qualify W2B / Draw W2W (more zones, draw as W2W)  
4=Qualify W2B / Draw adaptively (more zones, draw adaptively)  
0=use SettingsPreset 

MaxDistMergeZones ( 0.25 ) How close for zones to merge, relative to base height:  
5.00=Max  
0.00=Disable merging 

AlmostTouchTolerance ( 0.25 ) How close to zone for almost-touch, relative to base height:  
1.00=Max  
0.00=Ignore almost-touches 

See Zone types to show, Zone height rule, Merged zones and Touches and “almost touches” below for more details. 
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Zone types to show: All zones or only “authentic” ones 

The Input ZoneTypesToShow determines whether SD Zones will show ALL types of supply/demand zones (given the 
current Zone criteria) or only Drop-Base-Drop and Rally-Base-Rally zones (DBD and RBR).  

When set to show DBD & RBR only, Rally-Base-Drop and Drop-Base-Rally zones (RBD and DBR) are EXCLUDED both on 
charts and in RadarScreen. This is the default setting with SettingsPreset=2, 3 and 4 (Entry zones - Medium, Strict and 
Extreme, respectively), as you will see in the SD Radar workspaces. See Zone Criteria Preset above. 

Experienced supply/demand traders will know that RBD and DBR zones are usually not “authentic”, meaning they are 
usually formed as a reaction to a previous zone or other chart feature (to the left) thus depleting the orders in that 
previous zone, rather than being signs of new accumulation/distribution in themselves. Hence they are often less reliable 
as Entry zones. Some RBD and DBR zones CAN be fine as Entry zones, but they require careful manual qualification. 

DBD and RBR zones are ALWAYS authentic by definition: There can be no previous zones to the left of such zones, since you 
do not cross through Leg-ins (or through any bars) when looking for zones. 

RBD and DBR zones (the “inauthentic” ones) are still important on High Timeframe (HTF) charts, where you do not want to 
overlook zones that might affect “Big Picture” price context and preferred trade direction. RBD and DBR zones on HTF 
charts can cause reversals on the Entry timeframe trend. Thus Preset1 (HTF Zones - lax) still shows RBD and DBR zones. 

RBD and DBR zones are also shown in Preset0 (Chart confluence - medium lax) which should to be used in confluence with 
other trade signals. When previous zones are found (to the left) that cause new RBD/DBR zones to form, they are often 
displayed as combined (merged) zones on charts. See Merged zones below. 

Some users may prefer to include RBD and DBR zones when looking for Entry zones, without having to resort to Custom 
Zone Criteria. Therefore ZoneTypesToShow can be set to override the Preset: 

0: All zone types: show both DBD, RBR, RBD and DBR zones, regardless of SettingsPreset 
1: DBD & RBR only: show only DBD and RBR zones, regardless of SettingsPreset 
2: Use preset - show zones as determined by SettingsPreset. If SettingsPreset=99 (Custom Zone Criteria) show all zones 

When changed from the default ZoneTypesToShow=2 (Use preset), charts will extend their Chart Title to show DBD & RBR 
only or All zone types after the name of the chosen Preset. See Zone Criteria Preset above and Chart Title: Show the 
Zone Criteria Preset in effect below. 

ZoneTypesToShow can be easily changed using the Settings panel, which also allows you to apply changes to ALL charts 
and/or RadarScreen rows with a single mouse click. See Quick start: Settings panel above. 

Zone height rule: Wick-to-body or wick-to-wick 

SD Zones usually draws zones from the "outside wick" of the zone’s base to its "inside body". Performance measurements 
show that, statistically, this catches the most revisits with the smallest stop risk and the most winners. 

But the best zones sometimes never fill when you draw them this way: Price may turn already at the wick-to-wick level of 
the zone (W2W), and your entry order has to “front-run” the zone in order to get filled. Naturally, such front-running 
increases the stop distance, and thus the risk, compared to classic wick-to-body zones (W2B). But depending on your 
strategy, your win rate, and your chosen targets, that higher risk may be preferable to missing the trade. 

The ZoneHeightRule input allows zones to be qualified and/or drawn in other ways than the “classic” wick-to-body 
method. ZoneHeightRule accepts the following values: 

1: use wick-to-body: use wick-to-body (W2B) to qualify the zone and draw its lines (find more zones) 
2: use wick-to-wick: use wick-to-wick (W2W) to qualify the zone and draw its lines (find fewer zones) 
3: qualify W2B, draw W2W: use W2B to qualify the zone, draw it as W2W (find more zones, draw them taller) 
4: qualify W2B, draw adaptively: use W2B to qualify the zone, draw it as tall as the current zone criteria allow 
0: use preset: use W2B or W2W as determined by SettingsPreset (currently W2B for all presets, but may change) 

The reason for the different settings is that no one way to draw zones is perfect in all cases: 

ZoneHeightRule=1 (wick-to-body)  
This is how the SD Zones presets are tuned, using tens of thousands of zones over the last 20 years to maximize their 
performance. Because zones are shallower, they are more likely to qualify with a given set of zone criteria, since their Leg-
ins and Leg-outs are larger relative to the zone height. Thus it finds more zones. 
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ZoneHeightRule=2 (wick-to-wick)  
Makes the zone taller (increases its height), sometimes dramatically. Compared to ZoneHeightRule=1 (wick-to-body), it 
finds very few zones. You should use more lax zone criteria to compensate, such as SettingsPreset=2 or 0, or even Custom 
Zone Criteria (SettingsPreset=99 combined with manually tweaked Custom Zone Criteria inputs). See Zone Criteria Preset 
above. 

ZoneHeightRule=3 (qualify W2B, draw W2W)  
Will mostly find the same zones as the “classic” wick-to-body setting (ZoneHeightRule=1), but draws them at full wick-to-
wick height – even when such heights make little sense, such as when a base candle has wicks extending far above/below 
the other base candles. You should use very strict zone criteria to compensate, such as SettingsPreset=3 or 4, or even 
Custom Zone Criteria (SettingsPreset=99 combined with manually tweaked Custom Zone Criteria inputs. See Zone Criteria 
Preset above. 

ZoneHeightRule=4 (qualify W2B, draw adaptively) 
Similar to ZoneHeightRule=3 in that it mostly finds the same zones as the “classic” wick-to-body setting 
(ZoneHeightRule=1), but draws them at full wick-to-wick height – as long as their Leg-outs still qualify at that height with 
the current zone criteria. If not, it reduces their height so that the zone still qualifies. That's the adaptive part. 

ZoneHeightRule=4 (qualify W2B, draw adaptively) is recommended as the most sensible setting in most cases for those 
who want use wick-to-wick zones: It will find more zones from which to choose, draw them at wick-to-wick height, yet 
adapt their height to still be sensible. ZoneHeightRule=2 (wick-to-wick) or ZoneHeightRule=3 (qualify W2B, draw W2W) 
make sense if you have very specific rules and zone criteria which you know will give you the zones you want with wick-to-
wick zone qualification and/or drawing. 

When changed from the default ZoneHeightRule=0 (Use preset), charts will extend their Chart Title to show the selected 
rule after the name of the chosen Preset. See Zone Criteria Preset above and Chart Title: Show the Zone Criteria Preset 
in effect below. 

ZoneHeightRule can be easily changed using the Settings panel, which also allows you to apply changes to ALL charts 
and/or RadarScreen rows with a single mouse click. See Quick start: Settings panel above. 

Note: SD Zones shifts the OUTSIDE line of some small zones further out, so as to avoid unrealistically shallow zones relative 
to the surrounding volatility – and thus reduce the risk of stopout. By default, it increases the height of the zone to 50% of 
ATR at the time of leg-out (controllable with the input MinZoneHeightAdjATR). ZoneHeightRule=2, 3 and 4 will all shift the 
INSIDE line further inward, thus increasing the height of the zone. As a result, there is less need to shift the OUTSIDE line 
further out to fulfill the 50% ATR requirement. This is why you will see different OUTSIDE lines on some small zones when 
using different ZoneHeightRule settings. Some zones may break sooner because of this, which would have survived if the 
OUTSIDE line had been shifted further out. Of course that can be avoided with a higher MinZoneHeightAdjATR setting, but 
that in turn, will further increase the risk of the trade. Again, there is no perfect way to draw all zones in all cases.  

Touches and “almost touches” 

As described under Visual chart settings below, zone lines on charts are updated in real-time as price revisits (“touches”) a 
zone to show that it is no longer fresh: Inside zone lines turn from solid to dotted line style to show that it is touched. If 
price touches into a zone several times, or penetrates too deeply into the zone, it will be invalidated: Its Outside line will 
turn to dash-dot-dot line style. When a zone is broken completely (traded through), its lines will be truncated at the bar 
that broke it, and then removed on the next bar. 

When price trades close to a zone without actually touching into it, an “almost touch” is registered. This too will cause the 
zone to be marked as no longer fresh and its inside line changed to dotted style. “Almost touches” do not count as strongly 
towards invalidating a zone as “actual touches”, although they still count some. 

The AlmostTouchTolerance input defines how close to a zone price must come to register as an “almost touch”. A setting 
of 0.25 means price must come within 25% of the zone relative to its height. AlmostTouchTolerance=0 (zero) causes 
“almost touches” to be ignored, so that price must actually touch or trade into a zone in order to register.  

AlmostTouchTolerance can be easily changed using the Settings panel, which also allows you to apply changes to ALL 
charts and/or RadarScreen rows with a single mouse click. See Quick start: Settings panel above 
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Merged zones 

SD Zones will merge zones that are close to each other – or when a new zone is formed wholly or partially inside a “further 
out” zone. Merged zones are shown with a single set of Inside and Outside lines, but have individual Base hilites (the 
rectangles highlighting their bases). Sometimes multiple zones can end up being merged, particularly on HTF charts.  

How close zones must be in order to be merged is controlled with the MaxDistMergeZones Input (see Other zone criteria 
Inputs above). SettingsPreset=1 (Lax, HTF) merges zones more aggressively than SettingsPreset=2, 3 and 4 (Medium, 
Strict, Extreme). Regardless of SettingsPreset, MaxDistMergeZones can be changed to override the preset.  
MaxDistMergeZones=0 disables merging altogether. 

MaxDistMergeZones can be easily changed using the Settings panel, which also allows you to apply changes to ALL charts 
and/or RadarScreen rows with a single mouse click. See Quick start: Settings panel above. 

This way of showing merged zones takes a little getting used to, but is preferable to cluttering the chart with lines and 
labels for overlapping zones. 

Ignore zones formed overnight  

The Inputs IgnoreZonesAfter and IgnoreZonesBefore are used to tell SD Zones to ignore zones formed overnight. For 
example, IgnoreZonesAfter=1600 and IgnoreZonesBefore=0930 will tell it to only scan for zones formed during the US 
Stock market session (9:30am - 4pm ET) but NOT for zones formed during extended hours. IgnoreZonesAfter=1615 and 
IgnoreZonesBefore=0800 will tell SD Zones to scan for zones formed between the start of pre-markets (8am ET) and the 
settlement close (4:15pm ET) but NOT for zones formed overnight. 

Default settings for these inputs are IgnoreZonesAfter=2400 and IgnoreZonesBefore=0000 which tell the indicator NOT to 
ignore any periods. In other words, zones will be detected regardless of what time they were formed. 

The purpose of this setting is to avoid showing zones formed during periods with low institutional market presence which 
are often less reliable. However, be aware that overnight periods which have low volume in some markets (say, US Equity 
Index futures) may have high volume in other markets (say, Japanese Yen). 

IgnoreZonesAfter and IgnoreZonesBefore use the Time Zone selected on the chart (Local or Session). Make sure to enter 
values accordingly: For example, stocks sessions open 0930 US Eastern Time, 0630 US Pacific Time.  

TradeStation Regular Session vs Custom Sessions 
SD Zones can only detect zones formed during time periods which are included in the TradeStation session used in the 
chart or the RadarSreen window (search for Sessions in TradeStation Help). 

If you want to scan stocks for zones formed during pre- and post-markets you have to use TradeStation’s Custom Sessions 
(typically the 24 Hour custom session). The Regular Session for stocks does NOT include pre- and post-markets. Zones 
formed during extended hours in stocks are generally not recommended as trades because of the low institutional 
presence during those hours, but there are exceptions in very high volume stocks. 

You can select TradeStation’s 24 Hour custom session to show extended hours trading activity in charts, RadarScreen or 
both, in combination with IgnoreZonesAfter=1600 and IgnoreZonesBefore=0930 (US Eastern Time) to prevent zones 
formed outside the Regular Session from being detected. That way, SD Zones will update Proximity (the RadarScreen 
Proxim column) during extended hours and fire Proximity alerts, but using only zones formed during the regular session. 
See Proximity: Distance to nearest zone and Alerts and Notifications below.  

Note that zones formed during the Regular Session will be removed if broken by extended hours trading. Sometimes such 
zones could still work later, although their probability is generally lower. If you want to see zones formed during the Regular 
Session regardless of extended hours trading activity, you have to select Regular Session on the chart or RadarScreen. 

IgnoreZonesAfter and IgnoreZonesBefore can be easily changed using the Settings panel, which also allows you to apply 
changes to ALL charts and/or RadarScreen rows with a single mouse click. See Quick start: Settings panel above. 
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Visual chart settings 

The SD Zones indicator has a number of Inputs to control exactly how zones will appear on charts. Refer to the screenshot 
below for the various visual elements. 

Zones are always shown using Inside and Outside lines which start at the zone’s Leg-in bar and extend to the right edge of 
the chart window. The Inside line is closest to current price (upper line in demand zones, lower line in supply zones). The 
Outside line is furthest from current price (lower line in demand zones, upper line in supply zones). The color, transparency 
and thickness of these lines can be changed by Inputs. 

Zone price Labels are displayed for the Inside and Outside lines, justified to the right edge of the chart window. Color, 
transparency, font size and location of these labels can be changed by Inputs. Or they can be disabled entirely. 

The Base of each zone is highlighted with a semi-transparent rectangle to show the exact bars that make up the base. 
These Hilites are light yellow by default, but can be changed by Inputs. Or they can be disabled entirely. 

The Chart title shows the Zone Criteria Preset in effect: Chart confluence, HTF zones, Entry zones or Custom zone 
criteria. The font size, color, transparency and location of this title can be changed by Inputs. Or it can be disabled entirely. 
It can also be used to show a Custom Chart title or to show the version of the SD Zones indicator. 

Different line colors are used to distinguish Entry zones and HTF zones. By default Cyan for Entry zones and Magenta for 
HTF zones. Separate Chart titles are displayed when both Entry and HTF zones are shown on the same chart, with their 
colors matching those of their respective zone lines. See HTF zones overlaid on Entry charts below. 

The default colors for Zone lines, Zone price labels, Base hilites and Chart titles are meant to be visible without detracting 
from the price bars themselves. If you find them hard to see or read, you can change their transparency and/or colors. 

Visual chart settings Inputs 
Following is the complete list of Visual chart settings Inputs that control zone appearance on charts. Values in parentheses 
are defaults, used when the indicator is first added to a chart: 

ColorPreset ( 3 ) 0=Custom colors, 1=Black background, 2=White background, 3=Auto select 
ShowChartTitle( True ) show SettingsPreset, indicator version or custom title in top-left corner 
ShowHilites( True ) show rectangle highlighting base of zones 
ShowLabels( True ) show price labels with zone lines 
ShowInvalidatedZones ( True ) show zones that were touched too often or too deep, but not yet broken 
LabelRightJustify( True ) keep price labels at right edge of chart window 
FontName( "Arial" ) font name for price labels and chart title. ""=TradeStation default font 
LabelFontSize( 8 ) price label text font size 
TitleFontSize( 9 ) chart title text font size 

Chart title 

SUPPLY zone 

Price LABELS 

INSIDE line 
Dash-dot-dot Outside line: 
zone was invalidated by too 
many touches or too deep 
penetration 

 
DEMAND zone 

OUTSIDE line 

INSIDE line 

OUTSIDE line 

Dotted Inside line: 
zone was touched or 
"almost touched" 

2 MERGED Demand zones 

Solid Outside line: zone still valid 

2x Base HILITES  

NEAREST Demand/Supply zones 
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TitleShiftDown( 2 ) shift chart title down by x pixels 
CustomChartTitle( "" ) custom chart title, ""=show SettingsPreset, "version"=show version 
InsideLineWeight( 0 ) zone inside line weight 0-6, 0=thinnest 
OutsideLineWeight( 0 ) zone outside line weight 0-6, 0=thinnest 
ForceLinesOnChart1( False ) HTF overlay: draw zones from sub-graphs on main sub-graph 
HideOnAdvCharts ( True ) hide indicator on advanced chart types (Kagi, Renko, Range etc) 

Custom colors (used ONLY when ColorPreset=0) 
InsideLineColor( DarkCyan ) zone inside line color 
OutsideLineColor( Cyan ) zone outside line color 
InsLineTransparency( 20 ) zone inside line transparency 
OutsLineTransparency( 20 ) zone outside line transparency 
InsideLabelColor( SemiDarkCyan )  zone inside label color 
OutsideLabelColor( Cyan ) zone outside label color 
InsLabelTransparency( 0 ) zone inside label transparency 
OutsLabelTransparency( 0 ) zone outside label transparency 
HiliteColor( Yellow ) color of rectangle highlighting zone base 
HiliteTransparency( 80 ) transparency of rectangle highlighting zone base 
TitleColor( SemiDarkCyan ) chart title color 
TitleTransparency( 0 ) chart title transparency 
AlertBackgroundColor( DarkBlue ) RadarScreen background color to highlight symbols within proximity 

Color Preset 
The ColorPreset Input controls ALL the individual color and transparency settings for Lines, Labels, Hilites and Chart Titles 
as well as colors for the Nearest Demand and Nearest Supply “plots” displayed on the chart status line (see Nearest 
Demand and Supply zones below). ColorPreset accepts the following values: 

0: Custom - no preset, use custom color and transparency Inputs and TradeStation plot colors 
1: Black background - use preset colors optimized for black backgrounds (both charts & RadarScreen) 
2: White background - use preset colors optimized for white backgrounds (both charts & RadarScreen) 
3: Auto select - auto select ColorPreset1 on darker backgrounds, ColorPreset2 on brighter backgrounds 

You can still change the individual color settings through the Custom Color Inputs (see above list) and through 
TradeStation’s Format Indicator > Color tab (in TS10 Customize Indicator > Color tab), but you MUST set ColorPreset=0 
(zero) for them to take effect. When ColorPreset is any value OTHER than zero, the Custom Color Inputs are ignored since 
the ColorPreset controls color selections. 

When using Color Presets (ColorPreset=1, 2 or 3) the colors of zone lines will change based on the Zone Criteria Preset 
(SettingsPreset, see Zone Criteria Preset above): SettingsPreset=1 will choose HTF zone colors (magenta). Other 
SettingsPreset values (0, 2, 3, 4, 5, 99) will choose Entry zone colors (cyan). 

ColorPreset also controls colors in RadarScreen, including the Demand, Supply and Proxim columns as well as the 
Proximity alert and New Zone alert highlight colors. See Alerts and Notifications below. When ColorPreset is NOT in 
effect (ColorPreset=0) the highlight colors are controlled by the ProximAlertColor and NewZoneAlertColor Inputs. 

TradeStation color names 
Colors in TradeStation Inputs are numbers, but you usually enter them using one of the standard TradeStation color names: 
Black, Blue, Cyan, Green, Magenta, Red, Yellow, White, DarkBlue, DarkCyan, DarkGreen, DarkMagenta, DarkRed, 
DarkBrown, DarkGray or LightGray. Alternatively you can enter colors as RGB(red-value, green-value, blue-value) where 
each value is a number between 0 (darkest) and 255 (brightest). RGB(0,255,255) is Cyan, RGB(128,0,128) is DarkMagenta. 

Nearest Demand and Supply zones 
SD Zones constantly keeps track of the demand and supply zones which are nearest (closest) to current price, and displays 
them as “plots” on the status line of the chart for quick reference. By default they are placed on sub-graph 1 (the main 
graph of the chart window) but they can be moved to any sub-graph using the Format Indicator > Scaling tab (in TS10 
Customize Indicator > Scaling tab). The SD Radar workspaces place them on sub-graph 2 along with Volume and other 
useful indicators for futures, stocks and options. The colors used to display these Demand and Supply zone “plots” can be 
changed using TradeStation’s standard Format Indicator > Color tab (in TS10 Customize Indicator > Color tab). They are 
the same plots shown in RadarScreen Demand and Supply columns. Set ColorPreset=0 for changes on the Color tab to 
take effect. When ColorPreset is NOT zero, it controls color selections. 
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Line styles and zone “freshness” 
Once a zone has been detected, it will be drawn on charts and remain there until it is “broken” by price revisiting the zone 
and trading through its Outside line. The line styles are updated in real-time to show the zone’s “freshness”: 

As supply/demand zones are later revisited by price (“touched” or “almost touched”), SD Zones will change the line style of 
Inside lines from solid to dotted, to show that the zone is no longer “fresh”. If a zone is touched too often, or price 
penetrates too deeply into the zone, it will be invalidated, marked by its Outside line changing to a dash-dot-dot style.  

The dash-dot-dot outside line is SD Zones telling you that the zone should no longer be trusted as an entry zone! 

If a zone is broken (traded though) its lines will be truncated at the bar which broke them, so that you can see what 
happened to it. The lines will then be removed at the close of the bar. 

If you prefer to keep your charts clean and not show invalidated zones (ones with dash-dot-dot Outside lines) you can 
change the ShowInvalidatedZones Input to False on each chart, or change Invalidated zones in the Settings panel, which 
can be applied to all charts. See Quick start: Settings panel above. Invalidated and broken zones are never shown in 
RadarScreen, which is meant to only show potentially tradable Entry zones. 

The number of touches and how deep a touch can penetrate into a zone before it is invalidated are controlled by the Zone 
Criteria, either Zone Criteria Presets or Custom Zone Criteria (see Zone Criteria Preset above): 

Preset5 (Single-bar doji zones) invalidate on the 2nd touch or 5% into the zone 
Preset3 & 4 (Entry zones - strict & extreme) invalidate on the 2nd touch or 10% into the zone 
Preset2 (Entry zones - medium) invalidates on the 3rd touch or 35% into the zone 
Preset1 (HTF zones - lax) invalidates on the 8th touch or 80% into the zone 
Preset0 (Chart confluence - medium lax) invalidates on the 6th touch or 50% into the zone 

Line styles are used to indicate whether a zone is still “fresh” (has never been revisited since it was formed), been touched 
or “almost touched” (but may still be valid), or been invalidated (touched too many times or penetrated too deeply). 
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Right justify price labels on charts 
Price labels for Inside and Outside zone lines 
are aligned to the right side of the chart 
window, which makes it easier to see the 
price levels without having to scroll the chart 
back to the base of the zone.  

Unfortunately TradeStation does not provide 
an automatic way for price labels to be neatly 
kept at the right edge of the chart the same 
way as with Horizontal Lines or Fibonacci 
Retracement lines. So SD Zones constantly 
watches for changes to the chart window, 
such as new bars being added or the chart 
being scrolled up/down/left/right, and moves 
the price labels accordingly. SD Zones only 
performs this processing every 2 seconds, 
which is why you will see a small lag after 
scrolling the chart before the labels are 
moved. 

If you do not want right-justified price labels, 
the feature can be disabled by setting the 
Input LabelRightJustify=False. Price labels 
will then be placed next to the Leg-out of 
each zone. 

 

To make room for price labels at the 
right edge of the chart, you have to 
set TradeStation’s Space to the Right 
setting to a reasonable number of 
bars under RightClick menu > Format 
Window > General tab > Chart 
Properties (in TS10 RightClick menu 
> Settings > Window > General tab). 
A shortcut is to just double-click the 
chart background and select the 
General tab. 

For narrowly spaced charts, 12 is a 
good number. For wider spaced 
charts, you may be able to go as low 
as 4. You don’t want to change this all 
the time, so better choose a higher 
value from the start. 

 

 

Price labels for zone lines justified 
to the right edge of the chart. 
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Chart Title: Show the Zone Criteria Preset in effect 
SD Zones displays a Chart Title in the top left corner 
of the chart. The main purpose of this feature is to 
show the Zone Criteria Preset currently in effect, i.e. 
whether the chart displays Entry Zones or HTF zones 
(see Zone Criteria Preset above). This shows the 
“function” of each chart window.  

If you do not want to show the Chart title, it can be 
disabled by setting the Input ShowChartTitle=False. 

The Chart Title feature can also be used to display a 
custom title by entering a text string in the 
CustomChartTitle Input (in "quotation marks"). 
When left blank ("") the current SettingsPreset is 
displayed. 

The Chart title is placed just below the chart’s 
statusline (where TradeStation shows the symbol and 
other information). It can be shifted further down if 
desired, by entering a number of pixels for the Input 
TitleShiftDown. 

Separate Chart titles are displayed when both Entry 
and HTF zones are shown on the same chart, with 
their colors matching those of their respective zone 
lines (cyan or magenta). See Visual chart settings 
above. 

When using the HTF Overlay feature to show zones from a higher timeframe symbol (data series) overlaid on the Entry 
chart, the Chart title is automatically shifted down by one line. See HTF zones overlaid on Entry charts below.  

Instead of using Inputs, the Settings panel can be used to enable/disable the Chart title, or to enter a custom title, AND to 
change the font and size of the Chart title. This also allows you to apply changes to ALL charts and/or RadarScreen rows 
with a single mouse click. See Quick start: Settings panel above. 

HTF supply zone (to the left) 

 
CHART TITLES show 

colors and Zone 
Criteria of Entry and 

HTF zones 

HTF demand zone 

 

Entry demand zone 
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Settings panel 

The SD Zones indicator contains a number Inputs to control the criteria it uses to scan for supply/demand zones, visual 
settings for how they are displayed on charts and in RadarScreen, and many other features. While using Inputs to change 
settings will be familiar to TradeStation users, it is not always the most convenient or intuitive. SD Zones has a Settings 
panel, which can be used instead to quickly show and change its most commonly used settings.  

In charts, open Settings panel by Ctrl + RightClicking the chart background.  

In RadarScreen, open Settings panel by LeftClicking any Demand, Supply or Proxim cell and select Settings… from the 
ZoneMenu. Unfortunately TradeStation does not allow studies to use RightClick in RadarScreen.  

Settings panel is NOT available in TradeStation Scanner. 

SD Zones Settings panel provides fast access to the most commonly used SD Zones features. The Zone detection tab (left 
screenshot) controls zone criteria and related settings. The Visual settings tab (right screenshot) controls how zones are 
displayed on charts as well as the Chart Title in the top-left corner. The About tab (not shown here) shows the current SD 
Zones version and subscription status. The bottom section Apply settings to all windows… is shared between the tabs and 
controls how broadly to apply any changes. See Quick start: Settings panel above for more illustrations. 

Applying setting to ALL charts and RadarScreen rows 
By default, changes made in the Settings panel are applied to ALL Charts and ALL RadarScreen rows with the same 
SettingsPreset Input value. This is so that all Entry charts and all RadarScreen rows (which usually use the same 
SettingsPreset) can be updated separately from High-Timeframe charts (HTF) and vice versa. 

To apply changes ONLY to the charts or ONLY to the RadarScreen rows, toggle off the Apply to all Charts and/or Apply to 
all RadarScreen rows checkboxes. If both checkboxes are toggled off, changes are ONLY applied to the chart or 
RadarScreen row which opened Settings panel.  
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Also by default, changes are only applied to other charts and RadarScreen rows within the same workspace. To change 
this, select In ALL open workspaces. 

Click the big Apply updated settings button to apply the changes. 

Reverting individual settings to Input values 
Changing settings through the Settings panel does NOT change Input values. There is no way in TradeStation for a study 
to change its own Input values. Only a user can change them. 

Changes made with the Settings panel “override” the Input values in each chart and each RadarScreen row with the 
settings you selected. But those Input values remain and now become “default” settings to which you can easily revert. 

The little Inp (Input) buttons to the right of each setting revert just that setting to its Input value. Use them when you 
want to reset individual changes which you previously made. The Inp buttons merely revert the selections within the 
Settings panel the same way as if you manually changed those settings. The reverted settings will be applied ONLY when 
you click Apply updated settings, along with any other settings currently selected in the Settings panel.  

Reverting ALL settings to Input values 
The big Reset ALL to Input Values button reverts ALL settings to their Input values. It reloads immediately to apply the 
changes. It ALSO resets other Charts and RadarScreen rows if the Apply to all Charts and/or Apply to all RadarScreen 
rows checkboxes are toggled on. Next time you open the Settings panel, those Apply to… checkboxes will have been reset 
to their defaults as well. 

Reset ALL to Input Values is a fast way to “scratch all changes” in all charts and all RadarScreen rows and get them back in 
sync with each other, in case settings changes have been made in some of them but not in others. 

Saving settings changes with the workspace 
Changes made with the Settings panel persist when TradeStation saves the workspace. If you ever find that settings are 
missing when you later reload a workspace, it is a sign that TradeStation was in a corrupted state when the workspace was 
saved, causing it to dump the SD Zones data and revert to Input values. For this reason, it is recommended to use Input 
values as your “base settings” and use Settings panel mostly for temporary changes. If you want your workspaces to remain 
“untouched” with their original Input values, use Reset ALL to Input Values before saving the workspace.  

ShareSettings input: Enabling/disabling all sharing 
To completely disable sharing of settings with other 
charts and RadarScreen rows, change the 
ShareSettings input to False. You can still use Settings 
panel, but the Apply to… section will be grayed out 
(see screenshot). Other charts and RadarScreen rows 
with ShareSettings=True can still share settings, but 
any charts and RadarScreen rows with ShareSettings= 
False will not participate in the sharing. 

ShareWorkspaceName input: Sharing settings within named groups 
The Only within this workspace  feature limits sharing of settings to other charts and RadarScreen rows within the same 
workspace. Unfortunately the ability to distinguish workspaces only exists in TradeStation 10. In TS9.5, SD Zones uses In 
ALL open workspaces instead.  

You can enter a workspace name (or any name you 
want) in the ShareWorkspaceName input, thus 
allowing you to limit sharing of settings to charts and 
RadarScreen rows with the same name. The Only 
within this workspace selection will change to Within 
‘your group name’ (see screenshot). 

While the ShareWorkspaceName input exists mostly for TradeStation 9.5 users, it can also be useful for TS10 users who 
want to further control how charts and RadarScreen rows are grouped. ANY chart and RadarScreen row in ANY 
workspace with the same ShareWorkspaceName input value will become a group, allowing them to share settings 
changes separate from other charts and RadarScreen rows. 

Leaving ShareWorkspaceName blank will use the actual TradeStation workspace name, which is only supported in TS10. 

Note: When you copy/paste chart or RadarScreen windows containing SD Zones, all their Input values will be copied to the 
new windows. Make sure to clear or change ShareWorkspaceName in the copied windows so you do not apply future 
settings changes to them which you didn’t intend. Keep ShareWorkspaceName blank to avoid this gotcha. 
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Proximity: Distance to nearest zone 

The Proxim column (in RadarScreen) and the Proxim plot (in charts) show the distance from current price to the nearest 
supply/demand zone estimated in hours and minutes. It is based on current price volatility, and assumes price continues 
straight up or down at the current speed to the nearest zone. It is just an estimate, since price rarely moves straight up or 
down. But sometimes it does, and Proximity gives a good indication of how close a symbol is to its nearest zone. 

It is particularly useful in RadarScreen. You can sort on the Proxim column using RadarScreen’s Format Page > Sort tab (in 
TS10 RightClick menu > Settings > Sort tab), or just double-click the Proxim column header to sort by Proximity in 
ascending or descending order. This can be useful on long lists of stock symbols. 

However, the most powerful use of this feature is Proximity Alerts, where SD Zones highlights Demand or Supply cells in 
RadarScreen which are close to current price ( “within proximity”) and optionally fires TradeStation alerts. See Alerts 
and Notifications below. 

On charts, the Proxim plot (if enabled) shows on the status line after the plots for Nearest Demand and Nearest Supply. 
Like those, no actual Proximity graph is plotted, just the number on the status line. See Quick start: Chart Analysis above. 

By default, the color of the Proxim column/plot is controlled by the ColorPreset Input: Yellow on back backgrounds, blue 
on white backgrounds. As with the other plots (Nearest Demand, Nearest Supply) its color can be changed using 
TradeStation's Format Indicator > Color tab (in TS10 Customize Indicator > Color tab) after setting the input 
ColorPreset=0 (custom colors). When ColorPreset is NOT zero, it controls color selections. See Color Preset above. 

ShowProximPlot input: Show or hide the Proxim column/plot 
You can show or hide the Proxim column in RadarScreen (or the Proxim plot in charts) by changing the ShowProximPlot 
Input. RadarScreen will continue displaying an empty Proxim column unless you hide it with Show/Hide Plots (RightClick 
any SD Zones column). RadarScreen always creates columns for all plots in an indicator, even when they are empty. 

Since you often want to show Proxim in RadarScreen, but not in charts, the ShowProximPlot Input has an Auto feature. 
Values for the ShowProximPlot input are: 

0: Disabled - never show the Proxim column/plot 
1: Enabled - always show the Proxim column/plot (in charts, RadarScreen and Scanner) 
2: Auto - only show the Proxim column in RadarScreen and Scanner (not in charts) 

Proximity can also be enabled/disabled using the Settings panel, along with AlertProximity to control when Proximity 
alerts are triggered (see Alerts and Notifications below). Settings panel allows you to apply changes to ALL charts and/or 
RadarScreen rows with a single mouse click. See Quick start: Settings panel above. 

 

 

Proxim column in RadarScreen 
estimates proximity in hours and 
minutes to nearest zone.  Can be 
sorted (like here) by double-clicking 
the Proxim column header. 
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Alerts and Notifications 
One of the most powerful features of SD Zones is its ability to monitor many different markets in real-time, potentially on 
multiple intervals, and alert the user when a possible trade opportunity is coming up, either in the form of a newly created 
zone (so-called New Zone alerts) or by price approaching an existing zone (so-called Proximity alerts).  

New Zone alerts (if shown) will trigger anytime a new zone forms on charts or in RadarScreen. 

Proximity alerts (if shown) work in tandem with the Proximity feature (described above): SD Zones monitors current price 
and shows the distance to the nearest supply/demand zone in the RadarScreen Proxim column (Proxim plot on charts) 
estimated in hours and minutes. Proximity alerts will trigger when price comes “within proximity” of a zone, meaning 
Proxim falls below the threshold entered in the AlertProximity Input. 

AlertProximity: How close zones must be to trigger a Proximity alert 
The AlertProximity Input controls how close price must be to a zone for it to trigger a Proximity alert. It is the threshold at 
which a zone is considered “within proximity” of current price. You enter it in TradeStation’s HHMM format. 

The higher the AlertProximity value, the more zones will be “within proximity” and the more alerts you will receive. Too 
high an AlertProximity value and ALL zones will trigger. Enter a suitable threshold for your style of trading, such as 0030 (30 
minutes) for day trading, or 0630 (6½ hours) for position trading. 

You can enter a value larger than 24 hours, such as 4800. Just be aware that it counts “session hours”, not “calendar hours”. 
In futures (which trade 23 hours a day, 115 hours a week) 4800 will trigger alerts for zones up to two days away, but for 
stocks (which trade 6½ hours a day, 32½ hours a week) it will trigger alerts for all zones as far away as a week. 

Changing AlertProximity 
To update the AlertProximity Input in RadarScreen, 
RightClick the SD Zones column header and select 
Format ‘SD Zones’ for All Symbols > Inputs tab (in 
TS10 Studies > Edit ‘SD Zones’ for All Symbols > 
Inputs tab). This will update Inputs for ALL rows on 
that RadarScreen page. 

To update the AlertProximity Input in charts, use 
the Format Indicator > Inputs tab (in TS10 
Customize Indicator > Inputs tab). A shortcut is to 
double-click a zone line and click Yes, then select 
the Inputs tab. 

On the Inputs tab, AlertProximity is in the ALERTS 
& NOTIFICATIONS group. Enter a HHMM number. 

Changing AlertProximity with Settings panel 
AlertProximity can also be changed using Settings 
panel, which is often more convenient, particularly 
for temporary changes to increase or decrease the 
number of highlighted zones in RadarScreen. 

To open Settings panel in RadarScreen, LeftClick any 
SD Zones cell (Demand, Supply or Proxim) and 
select Settings… from the ZoneMenu. In charts, 
Ctrl + RightClick the chart background. 

In the Settings panel, AlertProximity is found in 
Zone detection tab > Alert when proximity to zone 
is within [HHMM]. 

Make sure the Proximity plot/column is shown. 
Otherwise the AlertProximity field is grayed out. 

Settings panel allows changes to be applied to ALL 
charts and/or RadarScreen rows. It does NOT 
update the actual Input values, but merely overrides 
them, and allows settings to be reset back to their 
Input values. See Quick start: Settings panel above. 



Supply/Demand Zones System for TradeStation 

37 

Displaying alerts in RadarScreen 
While SD Zones alerts can also trigger the firing of TradeStation alerts in charts, they are most powerful in RadarScreen, 
where hundreds of symbol rows can scan for zones and show real-time notifications for New Zone alerts and Proximity 
alerts by highlighting the background color of Demand or Supply cells. 

New Zone alerts:  DarkGray  (when using black backgrounds) or  Orange  (when using white backgrounds) tells you that a 
new zone was formed in that symbol.  

Proximity alerts:  DarkBlue  (when using black backgrounds) or  Yellow  (when using white backgrounds) tells you that a 
zone is “within proximity”, meaning Proxim has come within the threshold specified by the AlertProximity Input. 

The colors can be changed by setting ColorPreset=0 and changing the NewZoneAlertColor and ProximAlertColor Inputs. 

Clearing alerts in RadarScreen 
New Zone alerts stay highlighted until you manually clear them: LeftClick the highlighted Demand/Supply cell to show the 
ZoneMenu and select Clear this New Zone alert (you have to LeftClick since RadarScreen doesn’t support RightClick).  

To clear ALL New Zone alerts (say, if you come back to the computer and see a slew of orange alerts), LeftClick any SD 
Zones cell (Demand, Supply or Proxim) and select Alerts (ALL RadarScreen rows) > Clear ALL New Zone alerts. 

Proximity alerts are automatically cleared when price moves away from a zone, outside the AlertProximity threshold. You 
can clear Proximity alerts by manually invalidating a zone using ZoneMenu: LeftClick the highlighted Demand/Supply cell 
to show the ZoneMenu and select Invalidate this zone, which takes it off the RadarScreen list. You can use Restore this 
zone later if you want to give it a second look. See Invalidating and restoring zones under Quick start: ZoneMenu above. 

Both New Zone alerts and Proximity alerts are automatically cleared if the zone is broken or invalidated. Once cleared, 
there is no way to show the New Zone alert again for a given zone since it is no longer a new zone. Proximity alerts will 
trigger again if price comes “within proximity” of the zone later. 

Showing/hiding alerts in RadarScreen 
The easiest way to show/hide alerts in RadarScreen (i.e. enable/disable them) is using the ZoneMenu: LeftClick any SD 
Zones cell (Demand, Supply or Proxim) and select Alerts (ALL RadarScreen rows) > Show Proximity alerts and/or Show 
New Zone alerts (see screenshot above). This will show or hide the selected alerts for ALL RadarScreen rows within the 
current workspace, but NOT affect any other workspaces NOR any charts. Both Proximity and New Zone alerts are shown 
by default unless you toggle them off. 

New Zone alert (orange): Clear alert using 
ZoneMenu > Clear this New Zone alert. 
Clear ALL using Clear ALL New Zone alerts. 

Proximity alert (yellow): Automatically clears 
if price moves away from zone. Manually 
clear using ZoneMenu > Invalidate this zone. 

Show/hide alerts by toggling Show Proximity 
alerts and Show New Zone alerts. 

 

LeftClick a Demand or Supply cell to 
open the ZoneMenu for that zone. 

LeftClick any SD Zones cell (Demand, 
Supply or Proxim) to open the general 
ZoneMenu without a selected zone. 
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Showing/hiding alerts using the ShowAlerts Input 
To show/hide alerts for individual RadarScreen rows, or a range of rows, use the ShowAlerts Input: Select a Demand or 
Supply cell, or a range of cells while holding the Shift key, then use RightClick > Format ‘SD Zones’ for Selected Symbols > 
Inputs tab (in TS10 RightClick > Studies > Customize ‘SD Zones’ for Selected Symbols > Inputs tab).  

On the Inputs tab, ShowAlerts is in the ALERTS & NOTIFICATIONS group. It accepts the following values: 

0=NO alerts/notifications: No highlights will be shown in RadarScreen, no TradeStation alerts will fire 
1=Proximity alerts:  Proximity alerts will be highlighted in RadarScreen and fire as TradeStation alerts  
2=New Zone alerts:  New Zone alerts will be highlighted in RadarScreen and fire as TradeStation alerts 
3=BOTH Proximity and New Zone alerts: Both Proximity and New Zone alerts will be highlighted in RS and fire as TS alerts 
9=Charts NO alerts, RadarScreen BOTH alerts: NO alerts will trigger in charts, BOTH alerts will trigger in RadarScreen 

Default is 9, which automatically shows both Proximity and New Zone alerts in RadarScreen, but NO alerts in charts. 

Enabling TradeStation Alerts 
Enabling alerts in SD Zones, either using the ShowAlerts Input or the ZoneMenu as described above, will show the alerted 
zones as highlighted Demand and Supply cells in RadarScreen AND optionally fire TradeStation alerts IF enabled in 
TradeStation. This allows audible alerts and emails/text messages. See Configuring TradeStation Alerts below. 

To enable TradeStation alerts in RadarScreen, RightClick the SD Zones column header and select Alert > Enable Alert 
Continuously. This will enable TradeStation alerts for ALL symbol rows on the selected RadarScreen page. Proximity alerts 
already highlighted will fire immediately. Subsequent alerts will fire when new zones are formed or when price comes 
“within proximity” of existing zones. 

TradeStation alerts will fire only once for each New Zone or Proximity alert. Proximity alerts will fire again if price moves 
away from the zone and comes back “within proximity” later.  

Showing/hiding alerts in charts (TradeStation alerts) 
SD Zones alerts can also trigger in charts instead of RadarScreen. Alerts triggered in charts will fire TradeStation alerts, only 
if enabled and configured in TradeStation. Unlike in RadarScreen, there is no visual notification of SD Zones alerts in 
charts other than the firing of TradeStation alerts. Alerts are hidden by default in charts (i.e. disabled) unless you toggle 
them on. 

The easiest way to 
show/hide alerts in charts is 
using the ZoneMenu (see 
screenshot): RightClick 
either a zone line or the SD 
Zones Chart Title in the top-
right corner, then select 
Change on this chart only > 
Show Proximity alerts (TS 
Alerts) and/or Show New 
Zone alerts (TS Alerts). 

Alerts can also be enabled in 
charts using the ShowAlerts 
Input, the same way as 
described above for 
RadarScreen. 

Once you have selected to 
Show Proximity alerts 
and/or Show New Zone 
alerts, you need to also 
enable TradeStation alerts. 

Unfortunately, there is no way for SD Zones to automatically do this for you: Open Format Indicator for SD Zones (in TS10 
Customize Indicator). A shortcut is to double-click one of the lines created by SD Zones and click Yes. From there select 
Alerts tab > Enable Alert > Alert Continuously.  

See Configuring TradeStation Alerts below to set up audible alerts and emails or text messages. 



Supply/Demand Zones System for TradeStation 

39 

Configuring TradeStation Alerts 

The alert system in SD Zones ties into TradeStation's Alert feature so that you can receive audible and visual alerts and 
emails or text messages when you are away from your computer: EITHER when price first comes “within proximity” of a 
zone (Proximity alerts), OR when a new zone is formed (New Zone alerts), or BOTH. See Alerts and Notifications above. 

TradeStation alerts can fire from charts as well as from RadarScreen. In charts, TradeStation alerts are the ONLY notification 
that an alert has triggered. In RadarScreen, alerts are shown as highlights in the Demand or Supply cells IN ADDITION to 
firing TradeStation alerts. 

You typically enable TradeStation alerts only after you have reviewed highlighted zones in RadarScreen. Then you can leave 
your computer or do something else while waiting for TradeStation to alert you to symbols coming “within proximity” of a 
potentially tradable zone, or new zones forming. When you come back, the alerted zones will be highlighted in 
RadarScreen as described under Alerts and Notifications above. 

Definitions: Trigger vs Fire - Show SD Zones alerts vs Enable TradeStation alerts 
The term “trigger” an alert refers to the event itself: a new zone has formed (New Zone alert) or price has come “within 
proximity” of an existing zone (Proximity alert). As long as SD Zones is set to Show Proximity alerts or Show New Zone 
alerts, these events will “trigger” an action. 

“Showing/hiding” SD Zones alerts is done either through the ZoneMenu or through the ShowAlerts Input. See 
Showing/hiding alerts in RadarScreen, Showing/hiding alerts in charts and Showing/hiding alerts using the ShowAlerts 
Input under Alerts and Notifications above. 

The term “fire” a TradeStation alert refers to the action by the platform of playing a sound (Audible), showing a pop-up 
(Visual) and/or sending a message (Email). 

When an alert “triggers” in SD Zones, it calls on the platform to “fire” a TradeStation alert, which it will do according to 
TradeStation’s Alert Preferences, assuming TradeStation alerts have been “enabled” in the platform. To “enable” 
TradeStation alerts, see Enabling TradeStation Alerts under Alerts and Notifications above. 

The rest of this section contains simplified steps to configure TradeStation Alert Preferences. Please search for “Alerts” in 
TradeStation Help for more exhaustive information about the TradeStation Alert system. 

Unfortunately, there is no way for SD Zones to automatically do these things. They have to be configured by the user. 

Configuring TradeStation Alert Preferences 
To configure TradeStation Alert Preferences from RadarScreen, RightClick the SD Zones column header and select Format 
SD Zones for All Symbols > Alerts tab (in TS10 Studies > Edit '$SD Zones' for All Symbols  > Alerts tab). 

To configure TradeStation Alert Preferences from a chart, use the Format Indicator > Alerts tab (in TS10 Customize 
Indicator > Alerts tab). A shortcut is to double-click a zone line and click Yes, then select the Alerts tab. 

On the Alerts tab (see 
screenshot), check Enable Alert 
and Alert continuously (if you 
hadn’t already enabled 
TradeStation alerts previously). 

Select Use the global messaging 
preferences to apply the 
configuration settings made here 
throughout TradeStation. 

Select Use custom settings to 
apply the configuration settings 
made here JUST to SD Zones in this 
chart or this RadarScreen page. 

Click the Configure… button for 
the messaging preference you 
selected to show TradeStation’s 
Notification Preferences. 
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Configuring Notification Preferences 
Setting Audible and Visual preferences is easy enough on the Notification Preferences screen. Refer to TradeStation Help 
for further details on those. 

If you want to receive alerts as email or text messages, check Email and click Configure… to show TradeStation’s 
Messaging screen. 

Configuring Messaging settings 
The difficult bit is always configuring 
Email preferences, which requires that 
you enter settings and credentials for 
an email server to send the alerts (so-
called SMTP server).  

TO is the email address where you 
want to RECEIVE alerts. If you want to 
receive alerts as Text Messages, check 
with your cell carrier. For example, 
Verizon uses 1234567890@vtext.com 
(substitute your phone number). 

FROM is the email account from 
which alerts are SENT, for which you 
need to enter your email login 
credentials after checking My SMTP 
Server requires authentication. 
These have nothing to do with your 
TradeStation credentials. TradeStation 
essentially uses your email account as 
an email client program to send 
emails. 

Encryption settings (SSL/TLS/Port) 
vary between email providers. Check 
this TradeStation help page or ask 
your email provider. 

It IS possible to use a Gmail account 
as FROM address, but you must have 
Google generate a so-called App 
Password to use instead of your 
regular Google password. It's the 
same if you use any email program 
which Google doesn't know about. 
See Sign in with app passwords. 

Once you have entered your information, click Test to check that TradeStation is able to send alerts. Assuming the test is 
successful, click OK to save your settings. 

Setting up Messaging settings was always a hassle in TradeStation, but if you selected Use the global messaging 
preferences, you only have to do it once for all the different types of alerts in TradeStation. SD Zones merely asks the 
platform to fire an alert, the same as any other types of alerts you use in TradeStation. 

TradeStation Message Center 
Every alert TradeStation fires will be preserved as a line on the Alerts tab in the TradeStation Message Center so you can 
review the history of alerts. This is particularly useful if you use charts for SD Zones alerts instead of RadarScreen (where 
alerts are preserved as highlighted Demand/Supply cells).  

Open Message Center using TradeStation’s View Menu > Message Center > Alerts tab (in TS10 View Menu > Messages > 
Message Center > Alerts tab).  

You can remove individual alerts from the list after reviewing them using the Remove toolbar button in Message Center; or 
clear the entire list using the Erase toolbar button. You can also change your Notification Preferences using the 
Preferences toolbar button (see Configuring Notification Preferences above). 

https://help.tradestation.com/10_00/eng/TradeStationHelp/mc/messaging.htm
https://help.tradestation.com/10_00/eng/TradeStationHelp/mc/messaging.htm
https://support.google.com/accounts/answer/185833?hl=en
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Key/Mouse combo user actions 

When used in chart windows, SD Zones supports different user actions invoked by a combination of a keyboard key and 
one of the mouse buttons. The actions supported are described below.  

Scroll chart to base of a zone: Ctrl + Left Mouse-button 
When reviewing supply/demand zones shown on a chart by SD Zones, it is often necessary to scroll the chart to inspect the 
base of the zone and its Leg-in and Leg-out. Sometimes you have to scroll pretty far.  

The indicator provides a shortcut: Clicking one of its zone lines with the left mouse button while holding the Ctrl key will 
instantly scroll the chart to the base of the zone. This is VERY convenient for active supply/demand traders. Press the End 
key to get back to the right edge of the chart (assuming default TradeStation keyboard layout). 

In the case of merged zones, clicking the inside line will scroll to the “innermost” of the merged zones; clicking the outside 
line will scroll to the “outermost” of the merged zones. (See Visual chart settings above.) 

Settings panel: Ctrl + Right Mouse-button 
SD Zones contains a number Inputs to control the criteria it uses to scan for supply/demand zones, visual settings for how 
they are displayed on charts and in RadarScreen, and many other features. While using Inputs to change settings will be 
familiar to TradeStation users, it is not always the most convenient or intuitive. SD Zones has a Settings panel, which can be 
used instead to quickly show and change its most commonly used settings.  

In charts, open Settings panel by Ctrl + RightClicking the chart background.  

In RadarScreen, open Settings panel by LeftClicking any Demand, Supply or Proxim cell and select Settings… from the 
ZoneMenu. Unfortunately TradeStation does not allow studies to use RightClick in RadarScreen.  

Settings panel is NOT available in TradeStation Scanner. 

See Quick start: Settings panel and the section Settings panel above for more information. 

The Settings panel does not provide access to ALL features of SD Zones. In particular does it not allow setting Custom zone 
criteria, nor Custom colors, nor some other advanced features available through Inputs. Convenience is its purpose. 

KeyMouseCombo Input 
If you find the default Ctrl + Mouse-button features interfere with your work or with other programs, the key/mouse 
combination can be changed using the KeyMouseCombo input. It accepts the following values: 

0: Disabled: the Key/Mouse actions are disabled. This speeds up the indicator by a tiny bit, but mostly it can be used to 
avoid conflicts with other programs, or if you just want to avoid the key/mouse actions altogether. 

1: Mouse-button only: Left Mouse-button=Scroll to base – Right Mouse-button=Open Settings panel. No keyboard keys 
need to be pressed; just LeftClicking or RightClicking the mouse button. Be careful, as this “takes over” TradeStation’s 
regular mouse actions. 

2: Ctrl + Mouse Button: Ctrl+Left Mouse-button=Scroll to base – Ctrl+Right Mouse-button=Open Settings panel. Press and 
hold the Ctrl-key while clicking the mouse button. This is the default Input value. 

3: Alt + Mouse Button: Alt+Left Mouse-button=Scroll to base – Alt+Right Mouse-button=Open Settings panel. Press and 
hold the Alt-key while clicking the mouse button. 

4: Shift + Mouse Button: Shift+Left Mouse-button=Scroll to base – Shift+Right Mouse-button=Open Settings panel. Press 
and hold the Shift-key while clicking the mouse button. 

Note: If more than one instance of SD Zones is added to a chart, a Settings panel will open for each instance when 
Ctrl+Right Mouse-button is pressed. This can be avoided by using different KeyMouseCombo input values to select different 
key/mouse combinations. In cases where an SD Zones instance is based on a second symbol, such as when using the HTF 
Overlay feature (see HTF zones overlaid on Entry charts below) the indicator will automatically suppress opening of its 
Settings panel and show only the panel for the main symbol. To open the Settings panel for the HTF Overlay version, 
RightClick one of its zone lines (the magenta ones) and select Settings… from the displayed ZoneMenu. 
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Adding new zones intrabar (tick-by-tick) 

SD Zones allows a new zone to be detected while its Leg-out bar is still forming (so-called “intrabar”). It does this by 
checking for potential new zones on EVERY price tick. Because of the additional processing required doing this, SD Zones 
default behavior is to ONLY look for new zones intrabar on chart intervals of 60 min or higher (including Daily, Weekly, 
Monthly). The same applies to RadarScreen. So if RadarScreen is scanning a list of stock symbols on 60 min or Daily 
intervals it WILL automatically detect zones on every tick. Conversely, on symbol rows of smaller intervals (such as 3-15 min 
used for futures day trading) it will only detect new zones when each bar is completed.  

To further optimize intrabar detection of new zones, the process is limited to every 2 seconds. In normal markets and on 
normal computers, this has little effect, since the detection is already so fast. But during extremely fast moving markets, 
when a lot of price ticks come in every second, it limits the amount of CPU time consumed by the indicator. 

This default behavior can be changed with the AddZonesIntrabar Input: 

0: Disabled - never look for zones intrabar, only when bar completes 
1: Enabled (every 2 secs) - always look for zones intrabar, regardless of interval - limited to every 2 secs 
2: Auto (every 2 secs) - enable on 60 min or higher (incl. Daily, Weekly, Monthly) - limited to every 2 secs 
3: Auto (every 2 secs) - enable on 30 min or higher (incl. Daily, Weekly, Monthly) - limited to every 2 secs 
9: Enabled (EVERY tick) - always look for zones intrabar, regardless of interval - EVERY tick 

The Auto settings (2 and 3) are just a convenience to avoid having to change Inputs when setting up multiple chart 
windows or RadarScreen rows and pages, where the indicator is running on smaller intervals in some places and higher 
intervals in others. Just leave it on Auto (2 or 3) and it will adapt to the timeframe of each chart window and RadarScreen 
symbol row. 

TradeStation setting: Update value 
intra-bar (tick-by-tick) 
In order for TradeStation to allow SD 
Zones to run intrabar at all, the setting 
Update value intra-bar (tick-by-tick) 
must be enabled on the Format 
Indicator > General tab. It is enabled 
by default. This setting ALSO affects 
whether zones are updated intrabar 
when touched, invalidated or broken. 

Enable tick-by-tick setting to ensure 
zones can be detected and updated 
intrabar. 
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HTF zones overlaid on Entry charts 

Some traders prefer to “overlay” (superimpose) HTF zones on their Entry charts instead of watching separate High 
Timeframe charts. SD Zones supports this through the ForceLinesOnChart1 Input. 

TradeStation allows multiple symbols (so-called data series) to be added to the same chart window, each with their own 
timeframe (interval). For example, a second 60 min @ES symbol can be added to the window of a 10 min @ES chart, using 
TradeStation’s Insert menu > Symbol feature (in TS10 RightClick menu > Data > Add Symbol). This second symbol is 
usually placed as a chart on another sub-graph below the main chart, although it can be placed on any sub-graph using the 
Format Symbol > Scaling tab (in TS10 RightClick menu > Data > Edit Symbol > Scaling tab). Or it can be hidden altogether.  

In such a chart window, a second “instance” (copy) of the SD Zones indicator can be added based on the 60 min symbol 
instead of the 10 min symbol using Format Indicator > General tab > Base study on (in TS10 RightClick menu > Data > 
Edit Symbol > General tab > Base study on). This can be selected at the time SD Zones is added, by checking Prompt for 
Format on the Insert Analysis Techniques screen (in TS10 Prompt for Editing on the Add Studies screen). Please refer to 
TradeStation Help for more information about multiple symbols in chart windows. 

When adding SD Zones to the HTF symbol (60 min in this example) set the Input ForceLinesOnChart1=True to have it show 
HTF zones on the Entry chart (sub-graph 1) where they will be displayed along with Entry zones (“overlaying” them). Of 
course also set SettingsPreset=1 to look for HTF zones instead of Entry zones (see Zone Criteria Preset above). After this 
you can hide the HTF chart using the Format Symbol > Scaling tab so it doesn’t take up space (in TS10 RightClick menu > 
Data > Edit Symbol > Scaling tab). 

“SD Zones HTF” indicator variant 
A special HTF Overlay variant of the SD Zones indicator is included, named SD Zones HTF, with default inputs to make this 
process simpler, including different line colors to distinguish HTF zones (magenta) from Entry zones (cyan). It also adds a 
second Chart title to the chart to show the color of the HTF zones and the HTF interval. See Chart Title: Show the Zone 
Criteria Preset in effect above and Distinguishing Entry zones and HTF zones on charts below for screen examples. 

Because of the different names (SD Zones for Entry zones versus SD Zones HTF for HTF zones) it is easy to distinguish 
between the two indicator variants if you want to disable/enable one of them on a chart using TradeStation’s 
Enable/Disable Analysis Technique toolbar button or its RightClick menu (in TS10 RightClick menu > Studies > 
Enable/Disable Studies). Other than the names and different default Inputs, there are no differences between the two 
variants of the indicator. 

Note: The SD Zones HTF indicator variant is ONLY meant to be used to overlay HTF charts on Entry charts. In regular HTF 
charts (High Timeframe charts) you should use the regular SD Zones variant. Some Input values in the HTF variant have 
been set specifically to work around certain TradeStation issues when adding a second instance to a chart window. 

The SD Radar workspaces named HTF Overlay (see above) illustrate the intended use of the HTF Overlay feature. 

 

When adding the special SD Zones HTF 
indicator to a second symbol in a chart 
window, use Format Indicator > 
General tab > Base study on (in TS10 
Edit Symbol > General tab > Base 
study on) to select the HTF symbol 
(@ES 60 min in this case). This tells SD 
Zones which symbol to use when 
looking for zones. 
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High Timeframe Link (HTF Link) 

HTF Link is indicator included in the SD Zones package, designed for a streamlined futures trade-finding workflow. While 
TradeStation provides native Symbol Linking and Interval Linking, it lacks the ability to maintain a proportional relationship 
between different timeframes in Entry and HTF charts. 

HTF Link bridges this gap by maintaining a proportional relationship between your primary Entry chart and your High 
Timeframe chart (HTF). As you cycle through futures symbols and intervals in RadarScreen, HTF Link automatically scales 
the HTF chart to a higher interval -- typically a multiple like 5x or 10x -- ensuring you always get a HTF chart with an 
appropriate relation to your Entry chart, without having to calculate HTF intervals in your head or manually change the HTF 
chart. 

Core Functions 

• Automatic Interval Scaling: Multiplies the Entry 
interval to determine the appropriate HTF interval 
based on the HTF Interval Multiplier input. 

• Smart Rounding: Forces calculated HTF intervals 
to match common standard intervals (e.g., 
rounding a 25-minute calculated HTF interval up 
to 30 minutes). 

• Dynamic Timeframe Switching: Automatically 
transitions the HTF chart between Minute, Daily, 
Weekly, and Monthly timeframes as the Entry 
chart scales up and down. 

• Sync Status & Manual Override: Displays a Link 
Title in the bottom-left corner of the HTF chart; if 
it turns red, a simple Left-Click synchronizes the 
charts instantly. 

• Automatic HTF Update: If enabled, updates the 
HTF chart automatically, immediately when the 
Entry chart changes.  

 

SD Radar Workspace Implementation 

The SD Radar workspaces included with SD Zones are pre-configured to utilize HTF Link in different ways: 

Futures HTF Link Layouts: These workspaces are built specifically for the HTF Link workflow, featuring a large primary Entry 
chart and five smaller auxiliary charts. HTF Link is Enabled by default here. 

Futures Legacy Layouts: These contain the “classic” layouts delivered with SD Zones for years. HTF Link is Disabled by 
default to avoid platform-specific “gotchas”, but can be easily turned on via Enable/Disable Analysis Techniques (in TS10 
Enable/Disable Studies). 

Update Modes & Data Backfilling 

HTF Link operates in two primary modes to balance convenience and reliability across different chart types: 

1. Manual Update (Minutes workspaces): In the Day, Swing, and XL Swing workspaces, Automatic HTF Update is 
Disabled by default. TradeStation’s native Symbol Linking handles the symbol change. HTF Link detects changes to the 
Entry chart and turns its Link Title red with the text Click to update HTF chart when (and only when) the HTF chart’s 
interval needs updating. The user then clicks the red Link Title to update the HTF chart. 

2. Fully Automated (Ticks Workspaces): In Ticks workspaces, Automatic HTF Update is Enabled by default, and 
TradeStation Symbol Linking is disabled. This lets HTF Link manage both symbol and interval linking without 
interference from TradeStation. It automatically updates the HTF chart every time the Entry chart changes, which is 
particularly convenient in the Ticks workspaces where every symbol row in RadarScreen has a different interval. It is 
also a deliberate workaround for a TradeStation bug where the Link Title may be hidden during data backfilling; 
enabling Automatic HTF Update ensures the HTF chart updates even if the manual link button is temporarily invisible. 
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You can toggle Automatic HTF Update via the pop-up menu by right-clicking the Link Title. Note that when Automatic HTF 
Update is enabled, TradeStation Symbol Linking and Interval Linking MUST be disabled to avoid command conflicts. 

Interval Rounding Lists 

To ensure the HTF chart uses common intervals (15, 30, 60, 120, 240 min etc), HTF Link contains rounding lists in its inputs 
which the user can change as desired. It has separate lists for Minute, Second, Tick and Share-based charts.  

Time-Based charts (Minute and Second): The HTF Minute Intervals and HTF Second Intervals inputs come with default 
lists containing common intervals. You can add or remove any intervals to these as desired. They must be sorted, comma-
separated, and enclosed in quotation marks (e.g., "15,30,60,120,240,300…"). HTF Link will always round up to the next 
value in the list. Above the last interval in the list, HTF Link will use the exact calculated interval. 

Activity-Based chart (Tick and Share): The HTF Tick Intervals and HTF Share Intervals inputs are blank by default, 
allowing for exact scaling unless you enter preferred. The same rules apply as for the HTF Minute Intervals and HTF 
Second Intervals inputs. 

TradeStation “Gotchas” 

HTF Link issues command-line instructions to change interval of the HTF chart, the same way as if a user entered 120 min 
into the TradeStation Command Line. Unfortunately there is no other way in TradeStation for an indicator to change the 
chart interval. This requires navigating specific TradeStation behaviors: 

RunCommand Permission: On the HTF chart, you must go to the General tab of TradeStation’s Format Indicator dialog (in 
TS10 Customize Indicator) check Enable RunCommand with Confirmation OFF. You must agree to the Enable Order 
Generation warning that follows. HTF Link does not issue trade orders; it only uses this permission to change symbols and 
intervals. 

 

 

 

Platform Warnings: TradeStation will 
display security warnings when 
opening or closing workspaces using 
HTF Link. These are standard for any 
indicator utilizing RunCommand. 
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The “Focus” Requirement: The HTF chart often needs focus for several seconds while it updates. If you click elsewhere (in 
RadarScreen or another chart) during the split second the command is issued, it can fail or cause the command to affect 
the wrong window. To avoid errors, do not click anywhere else while waiting for the HTF chart to finish its update. 

Version Limitation: Automatic HTF Update is not supported in TradeStation 9.5, as that version lacks the required focus-
stealing functionality.  

TradeStation 10 has supported focus-stealing since Update 84 (Rev 1404), but changed its implementation starting in 
Update 89 (Rev. 1428). Unfortunately it is not possible for an indicator to contain code for both the older and newer 
implementation, so HTF Link requires TS10 Update 89 or newer. 

HTF Link Inputs 
HTF Link accepts the following inputs. The values in parentheses are defaults when first adding it to a chart 

Entry or HTF ( 0 ) 1=Entry chart, 2=HTF chart - TS Symbol & Interval Link must be set to [Not Linked], 
0=suspend HTF Link 

HTF Interval Multiplier ( 5 ) HTF interval relative to Entry interval - suggested 5-10 

HTF Minute Intervals ( "15,30…" ) HTF Minute intervals to use (sorted, comma-separated, round to higher) - blank=use 
any minute interval 

HTF Second Intervals ( "15,30…" ) HTF Second intervals to use (sorted, comma-separated, round to higher) - blank=use 
any second interval 

HTF Tick Intervals ( "" ) HTF Tick intervals to use (sorted, comma-separated, round to higher) - blank=use any 
tick interval 

HTF Share Intervals ( "" ) HTF Share/Volume intervals to use (sorted, comma-separated, round to higher) - 
blank=use any share/volume interval 

Shares Not Ticks ( False ) True=use Share bars (Volume charts) in HTF chart instead of Tick bars. Old TS versions 
won't let HTF Link distinguish Share bars from Tick bars. Enable this if Share bars in the 
Entry chart become Tick bars in the HTF chart 

Dynamic HTF Timeframe (True ) True=dynamically change HTF Timeframe between Minute/Daily/Weekly/Monthly - 
False=use same HTF Timeframe as Entry chart 

Automatic HTF Update (False ) True=automatically update HTF chart as needed to reflect Entry chart (TS10 only) - 
False=manually update by clicing Link Title in bottom-left corner 

Show Link Title (True ) True=show Link Title (''Entry chart'' or ''HTF chart'') in bottom-left corner of chart - 
False=don't show Link Title 

Title Font Size ( 9 ) Font size for Link Title - min=4, max=24 

Title Up From Bottom ( 6 ) Pixels between Link Title and bottom of chart 

Link Group Name ( "" ) Link specific Entry/HTF chart pairs with the same group name - if multiple Entry/HTF 
chart pairs are loaded in the same or other workspaces  
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Input settings (complete list) 

SD Zones contains a number of settings, managed through so-called TradeStation Inputs, which control the criteria it uses 
to scan for supply/demand zones, visual settings for how they are displayed on charts and in RadarScreen, and how and 
when it notifies you of newly formed zones or when price approaches an existing zone that might be a potential trade. 

You change these Inputs using TradeStation’s Format Indicator > Inputs tab (in TS10 Customize Indicator > Inputs tab). 

Change Inputs in Charts 
In charts, use RightClick menu > Analysis Techniques > SD Zones > Format > Inputs tab (in TS10 RightClick menu > 
Studies > Edit Studies > SD Zones > Customize > Inputs tab). A shortcut is to double-click one of the lines created by SD 
Zones and click Yes, then select the Inputs tab if it isn't already shown. Note that this will change Inputs ONLY for that 
chart window. TradeStation offers no way to automatically update Input values in multiple charts. 

Note: Many chart settings can be changed or toggled with just a few mouse clicks using ZoneMenu > Change on this chart 
only. This temporarily overrides the Input values, but doesn’t actually change them. See Quick start: ZoneMenu above. 

Change Inputs in RadarScreen 
In RadarScreen, RightClick the SD Zones column header and select Format ‘SD Zones’ for All Symbols (in TS 10 RightClick 
menu > Studies > Edit ‘SD Zones’ for All Symbols). This applies the changes to ALL symbol rows on that RadarScreen page. 

You can also change just a single row in RadarScreen, or select a range of Demand or Supply cells with the Shift key and 
select Format ‘SD Zones’ for Selected Symbols (in TS 10 RightClick menu > Studies > Customize ‘SD Zones’ for Selected 
Symbols). 

Change Inputs in Scanner 
In Scanner, add $SD Zones on the Scan Criteria tab using Select Criteria > Indicator…, then change its Input values by 
clicking the little + sign next to SD Zones to show its full list of Inputs in the Input/Settings Name column and change their 
values in the Values column.  

On the $SD Zones Criteria line, make sure to select Alert in the Field column and True in the Operator column. This will 
scan for symbols which are “within proximity” of a supply/demand zone and use the Alert feature to include it in the scan 
results. The AlertProximity input determines how close the zone must be in HHMM. See Quick Start: Scanner above. 

Change settings with Settings panel 
Instead of changing TradeStation Input values, many of the most common settings can be changed using the Settings 
panel, either from charts or from RadarScreen. This overrides the Input values, and can even apply the settings to other 
charts and RadarScreen rows with a single click. But it doesn’t change the Input values themselves. Rather, the input 
values become defaults, to which each setting can easily be reverted. See Quick start: Settings panel above. 

 

Complete list of Inputs 
Following is the complete list of all Inputs. Most are described more extensively in the sections above under Indicator 
Feature Descriptions, particularly Zone Criteria Preset and Visual chart settings. 

The values in parentheses are defaults when first adding SD Zones to a chart, RadarScreen or Scanner window. 

Zone criteria preset 
SettingsPreset ( 0 ) 0=Chart confluence (medium lax)  

1=HTF zones (lax)  
2=Entry zones (medium)  
3=Entry zones (strict)  
4=Entry zones (extreme)  
5=Entry zones (ticks)  
6=Entry zones (single-bar doji) 
99=Custom zone criteria (use inputs) 

Color preset 
ColorPreset ( 3 ) 0=Custom colors (inputs), 

1=Black background  
2=White background 
3=Auto detect black/white background 
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Other zone criteria: used regardless of SettingsPreset, overriding presets 
ZoneTypesToShow ( 2 ) 0=Show ALL zone types  

1=Show DBD & RBR only  
2=Use SettingsPreset, if Preset99 show all zones 

ZoneHeightRule ( 0 ) 1=Qualify and draw zones Wick-to-Body (find more zones)  
2=Qualify and draw zones Wick-to-Wick (find fewer zones)  
3=Qualify W2B / Draw W2W (more zones, draw as W2W)  
4=Qualify W2B / Draw adaptively (more zones, draw adaptively)  
0=use SettingsPreset 

MaxDistMergeZones ( 0.25 ) How close for zones to merge, relative to base height:  
5.00=Max  
0.00=Disable merging 

AlmostTouchTolerance ( 0.25 ) How close to zone for almost-touch, relative to base height:  
1.00=Max  
0.00=Ignore almost-touches 

Ignore zones formed overnight: between "After" time and "Before" time 
IgnoreZonesAfter ( 2400 ) Ignore zones formed after this time (HHMM), 2400=ignore none 
IgnoreZonesBefore ( 0000 ) Ignore zones formed before this time (HHMM), 0000=ignore none 

Alerts & RadarScreen notifications: TradeStation Alerts fire if enabled in TS 
ShowAlerts ( 9 ) 0=NO alerts/notifications  

1=Zone proximity alerts  
2=New Zone alerts  
3=BOTH Proximity and New Zone alerts  
9=Charts NO alerts, RadarScreen BOTH alerts 

AlertProximity ( 0100 ) Alert/notify when proximity to zone is within HHMM entered here 

ShowProximPlot ( 2 ) 0=NEVER show proximity column/plot 
 1=ALWAYS show proximity column/plot (h.mm) 
 2=Show proximity column/plot in RadarScreen & Scanner only (h.mm) 

Visual chart settings: control zone drawing on charts 
ShowChartTitle ( True ) show SettingsPreset or custom title in top-left corner 
ShowHilites(  True ) show rectangle highlighting base of zones 
ShowLabels ( True ) show price labels with zone lines 
ShowInvalidatedZones ( True ) show zones that were touched too often or too deep, but not yet broken 
LabelRightJustify ( True ) keep price labels at right edge of chart window 
FontName ( "Arial" ) font used for price labels and chart title, ''''=TradeStation default 
LabelFontSize ( 8 ) price label text font size 
TitleFontSize ( 9 ) chart title text font size 
TitleShiftDown ( 2 ) shift chart title down by x pixels 
CustomChartTitle ( "" ) custom chart title, ""=show SettingsPreset 
InsideLineWeight ( 0 ) zone inside line weight 0-6, 0=thinnest 
OutsideLineWeight ( 0 ) zone outside line weight 0-6, 0=thinnest 
ForceLinesOnChart1 ( False ) HTF overlay: draw zones from sub-graphs on main graph 
HideOnAdvCharts ( True ) hide indicator on advanced chart types (Range, Kagi etc) 

Custom colors: used ONLY when ColorPreset=0, ignored when ColorPresets are in effect 
InsideLineColor ( Cyan ) zone inside line color 
OutsideLineColor ( BrighterCyan ) zone outside line color 
InsLineTransparency ( 40 ) zone inside line transparency 
OutsLineTransparency ( 0 ) zone outside line transparency 
InsideLabelColor ( SemiDarkCyan ) zone inside label color 
OutsideLabelColor ( Cyan ) zone outside label color 
InsLabelTransparency ( 0 ) zone inside label transparency 
OutsLabelTransparency ( 0 ) zone outside label transparency 
HiliteColor ( Yellow ) color of rectangle highlighting zone base 
HiliteTransparency ( 80 ) transparency of rectangle highlighting zone base 
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TitleColor ( SemiDarkCyan ) chart title color 
TitleTransparency ( 20 ) chart title transparency 
ProximAlertColor ( DarkBlue ) RadarScreen background color for Proximity notifications 
NewZoneAlertColor( DarkerGray ) RadarScreen background color for New Zone notifications 

Custom Zone Criteria: used ONLY when SettingsPreset=99, ignored when SettingsPresets are in effect 
MinZoneBars ( 1 ) min number of bars in base 
MaxZoneBars ( 8 ) max number of bars in base 
MinZoneHeightSkipTicks ( 3 ) min height of base in ticks - or skip zone 
MinZoneHeightSkipATR ( 0.1 ) min height of base relative to ATR - or skip zone 
MinZoneHeightAdjATR ( 0.5 ) min height of base relative to ATR - or adjust height 
ATRLength ( 36 ) number of bars for ATR calculation 
MinLegoutSize ( 1.25 ) min size of Leg-out (relative to height of base)  
MinLeginSize ( 0.90 ) min size of Leg-in (relative to height of base)  
MinBaseBarScore ( 0 ) min bar score for Base bars 
HiConfBaseBarScore ( -6 ) high confidence score for Base bars 
MinLegBarScore ( 2 ) min bar score for Leg bars 
HiConfLegBarScore ( 2 ) high confidence score for leg bars 
MinLegBar2Score ( 1 ) min score for following Leg bars 
MaxLegoutBarBreakATR ( 0.1 ) max above/below base on Leg-out bar relative to ATR - or skip zone 
MaxTouchBarsInvalid ( 6 ) max bars touching into zone before it's invalidated 
MaxTouchDepthInvalid ( 0.5 ) how deep into zone before it's invalidated (relative to base height)  
MinLegoutMove ( 0.75 ) min size of move from base for first Leg bar (relative to base height)  
MinLegBarMoveATR ( 1.00 ) min bar move to continue a leg (relative to ATR) 

Misc settings: rarely need changing 
DaysToLookBack ( 0 ) how many days back to look for zones, 0=entire chart 

AddZonesIntrabar ( 2 ) 0=NEVER add zones intrabar, only on bar close 
 1= ALWAYS add zones intrabar (only every 2 secs)  
 2=Add zones intrabar on 60 min intervals and higher (only every 2 secs) 
 3=Add zones intrabar on 30 min intervals and higher (only every 2 secs) 
 9=ALWAYS add zones intrabar (on EVERY tick)  

Key/Mouse combo user actions 
KeyMouseCombo ( 2 ) 0=Disable key/mouse actions 
 1=MouseButton only – LeftBtn=ScrollToZone, RightBtn=Settings panel 
 2=Ctrl+MouseButton – Ctrl+LeftBtn=ScrollToZone, Ctrl+RightBtn=Settings panel 
 3=Alt+MouseButton – Alt+LeftBtn=ScrollToZone, Alt+RightBtn=Settings panel 
 4=Shift+MouseButton – Shift+LeftBtn=ScrollToZone, Shift+RightBtn=Settings panel 

Share settings between Charts/RadarScreen rows 
ShareSettings ( True ) False=disable sharing between charts/RS rows using same SettingsPreset Input value 
ShareWorkspaceName ( "" ) group name for this chart/RadarScreen row when sharing settings 
 ""=use workspace name (TS10) / share with all ALL workspaces (TS9.5)  

Internal use only: for testing, debugging and backwards compatibility 
ShowZones ( True ) show zone lines on chart: false=show only plots (nearest zones & proximity) 
ShowBrokenZones ( False ) show broken historical zones. Shows ALL merged zones. Debug only 
TitleVertOffset ( 2 ) backwards compatibility: leave at 2 or 16.  
 Use TitleShiftDown to change location of chart title 

Keeping RadarScreen and charts in sync 
Make sure Input settings in RadarScreen which affect zone criteria match those same Inputs in linked chart windows. For 
example, if the symbol rows in RadarScreen use an Interval of 60 min (as set by RightClick Symbol column > Format All 
Symbols, in TS10 RightClick Symbol column > Timeframe > Customize > All symbols) that means TradeStation will treat 
each row as a 60 min chart. If you also have a linked 60 min chart window to show the detected zones, make sure it uses 
the same Zone Criteria (SettingsPreset, ZoneTypesToShow, ZoneHeightRule, IgnoreZonesAfter/Before, etc) in order to 
detect the exact same zones on the chart as were found in RadarScreen. 

Note that charts by default show Invalidated zones using dash-dot-dot outside lines. RadarScreen only shows zones which 
haven't yet been invalidated since they are no longer considered trade candidates.  
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 Input ToolTips (TradeStation 10 only) 
Most Input fields are fairly self-explanatory from their names: InsideLineColor sets the color of inside zone lines; 
ShowLabels shows (or hides) price labels; and so forth. 

But some Input fields require more explanation. For example SettingsPreset selects a preset for zone criteria, with possible 
values being 0, 1, 2, 3, 4, 5 (or 99 for Custom Zone Criteria). See Zone Criteria Preset above for details. 

In TradeStation 10, hovering the mouse cursor over the name of each Input field will show a ToolTip describing what the 
Input does and the different values which can be entered. 

TradeStation 10 ToolTips: Hover the mouse cursor over the Input name to show the ToolTip. 

Input {Descriptive comments} (TradeStation 9.5 only) 
Earlier TradeStation versions do not support ToolTips. Instead, the SD Zones Input fields have descriptive comments in 
{curly braces}. Hover your mouse cursor over the value to show the full description. 

The {descriptive comments} look confusing, but they are the only way in earlier TradeStation versions to provide help on 
each Input. When you change values in those fields, just leave the {descriptive comments} alone. Or you can delete them 
entirely, including the curly braces, if you prefer them out of the way. 

Note: Since by far the majority of SD Zones users run TradeStation 10, the SD Radar Stocks workspaces were created 
WITHOUT {descriptive comments} to provide the most clarity for the most users. TS9.5 users are advised to use the above 
list of settings for reference when modifying Inputs in SD Radar workspaces. 

Remember, the Settings panel and the ZoneMenu are easy alternatives to updating Input values for the most common 
settings. See Quick start: Settings panel and Quick start: ZoneMenu above. 

TradeStation 9.5 Descriptive comments in {curly braces}: Hover the mouse cursor over the Input value to read the entire 
description as a fly-out tooltip. You can change the comments or delete them without affecting the indicator. 
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Input group headings 
Many Inputs are grouped under group headings, 
which are simply Inputs themselves with names in all 
caps and a short text describing the group of Inputs 
below. It looks crude, but TradeStation offers no other 
way to group Inputs. The group headings have no 
function other than to describe the purpose and use 
of the Inputs.  

You can edit or delete their text without affecting the 
indicator. 

 

 

 

 

 

 

TradeStation Inputs DEFAULT button 
TradeStation has a Default button on the Inputs tab, 
which is used to save the Input values currently 
entered as future defaults when the indicator is 
added to another chart or RadarScreen.  

Using this button IS NOT RECOMMENDED with SD 
Zones as it effectively updates the indicator code to 
change its default Input values. There is no way to 
restore the original defaults other than re-installing 
the indicator. 
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Fixing TradeStation Download Scheduling 

If TradeStation seems more than usually slow to populate RadarScreen pages with many symbol rows – such as the SD 
Radar Stocks Swing or SD Radar Futures XL Swing workspaces, but also other workspaces, whether they use SD Zones or 
not – you should check TradeStation’s Download Scheduler Request settings. 

Open View menu > Download Scheduler > Scheduled Items tab (in TS10 View menu > Messages > Download Scheduler 
> Scheduled Items tab). If any items scheduled for download say Off peak instead of ASAP in the Priority column, that 
means TradeStation is set to NOT download data immediately. In that case, or if the data download does not make 
progress, try the following steps: 

1) Exit TradeStation. 

2) Delete all files in the folder C:\Program Files 
(x86)\TradeStation 9.5\Program\Cache (in TS10 
Documents\TradeStation 10.0\CAL\Cache). If you 
manually placed your TradeStation cache folder 
somewhere else, delete its contents in that location. 

3) Load TradeStation again. 

4) Create a chart window (or open a simple 
workspace that contains a chart window). 

5) Select View menu > Chart Analysis Preferences > 
Data tab (In TS10 RightClick menu > Settings > 
Preferences > Data tab) and enable Show Download 
Request Scheduler... 

6) Change to a different symbol in the chart window 
and select an intraday timeframe, say 2 min. This 
should open a Download Scheduler Request window. 
If it doesn’t, try another symbol and/or interval to 
force TradeStation to download some chart data. 

7) In the Download Scheduler Request window that 
pops up, select As soon as possible and Remember 
this setting and do not display this message again, 
then click OK. 

8. Now load the workspace again that caused the 
problem and let TradeStation finish completing all 
tasks displayed on the Scheduled Items tab in 
Download Scheduler. 

 

Note: It is ALWAYS advisable to let TradeStation complete data downloading and any other tasks without interruption, even 
when they take a long time. TradeStation does all these tasks in the background and lets you continue working, but the 
truth is that interrupting TradeStation while it is busy, is one of the surest ways to cause it to hang, crash or otherwise 
become unstable. This is particularly true while it is downloading data through the TradeStation Client Access Layer module 
(CAL). 
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Speeding up TradeStation (particularly TS10) 

As TradeStation has gone from version 9.1 (the most stable I’ve seen since 2009) to 9.5 and later TS10, it has become 
increasingly slower. TS10 in particular can become dramatically slower, unless special care is taken. 

A key reason for TS10 slowness, is that all of its internal work folders and files have been moved from the main Program 
Files folder where they were located in previous versions (C:\Program Files (x86)\TradeStation 9.5) to the user’s regular 
Documents folder (Documents\TradeStation 10.0). This is perfectly in line with Windows guidelines, but it means that the 
files are now subject to real-time Anti-Virus scanning, and sometimes to real-time backup by OneDrive or Google Drive. 
In the case of TradeStation’s data cache, which is updated with every trading tick of new data coming in from the market, 
this real-time Anti-Virus scanning and backup will slow it down quite severely. Fixing it can dramatically speed up and 
improve the stability of TS10. They will also speed up TS9.5, though to a lesser extent. 

Excluding from real-time Anti-Virus scanning 
To avoid real-time Anti-Virus scanning of TradeStation files, use the settings in your Anti-Virus software to exclude 
TradeStation processes (program files) and work folders (C:\Program Files (x86)\TradeStation 9.5 for TS9.5, 
C:\Users\Username\Documents\TradeStation 10.0 for TS10). I have created a list of all the relevant folders, file types and 
processes to exclude, which you can download with the following link. The exact steps to add these exclusions depend on 
your Anti-Virus software. See the TS10 re-installation guide linked below if you are using Windows’ built-in Anti-Virus. 

Speeding up TS performance.txt 

Avoiding OneDrive / Google Drive real-time backup  
If your Documents folder is being backed up to OneDrive or Google Drive, you should disable that as well to avoid real-time 
backup of the TradeStation 10.0 subfolder inside your Documents folder. But be careful, as disabling Documents backup 
may cause ALL files and sub-folders in your Documents folder to be removed from the local computer, remaining only in 
the OneDrive / Google Drive cloud. Perform a full TradeStation backup first (File > Backup/Restore TradeStation). 

If you have not yet installed TS10, disable Documents backup in OneDrive / Google Drive settings before you install TS10. 

See the TS10 re-installation guide linked below for detailed steps to backup, uninstall and re-install TradeStation 10, 
including how to work around OneDrive and set exclusions for Windows’ built-in Anti-Virus. It also includes steps to 
troubleshoot instability with TS10, partially applicable to TS9.5 as well. 

Re-installing TradeStation 10 - the complete guide (PDF) 

Using OneDrive with TradeStation 
I personally use OneDrive extensively, including for my TradeStation work files. It works great, both to keep files backed up 
and to make them available on multiple PCs. But I make VERY sure that it is NOT set to back up my Documents folder. 

To use OneDrive with TradeStation files AFTER disabling Documents backup, simply create sub-folders in your OneDrive 
folder, such as OneDrive\TradeStation\Workspaces and OneDrive\TradeStation\Archives. When you save workspaces or 
backups in TradeStation, just click Browse and navigate to those OneDrive sub-folders instead of saving in the default 
Documents\TradeStation 10\Workspaces and Documents\TradeStation Archives folders.  

This way you remain in full control of what is automatically backed up, and the workspace and backup files will still be 
synchronized between computers. All TradeStation’s internal folders and files and its cache are not suitable for 
synchronization anyway. 

TradeStation Community Forum Discussions 
TradeStation’s Community Forum has some useful discussions on these subjects. Check the following topics. You need to 
login to the TradeStation website BEFORE clicking these links. 

OneDrive and TradeStation 10 

• Read Solidus’ opening post on page 1 
• Read Dannemand’s post on page 2 
• Ignore everything else in the thread 

RAM drive for TS Cache (and other stuff) 

• Read Dannemand’s opening post on page 1 
• Read Dannemand’s post #4 to move Edge folders to RAM Drive 

https://sdzones.com/downloads/Speeding_up_TS_performance.txt
https://sdzones.com/downloads/Re-installing_TradeStation_10_complete_guide.pdf
https://community.tradestation.com/Discussions/Topic.aspx?Topic_ID=173253
https://community.tradestation.com/Discussions/Topic.aspx?Topic_ID=212360
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FAQ: Frequently asked questions 

Use SD Zones to FIND zones, not just to SHOW them 

Maybe to the surprise of some, SD Zones was NOT developed primarily to show supply/demand zones on a chart. 

Sure, you can put it on a chart, and it will show you supply/demand zones, some of which might be potential trades, some 
may not. If you are a skilled supply/demand trader, your eyes will quickly tell you. But then your eyes are already trained to 
see zones on a chart. 

Rather, SD Zones was developed to find potentially tradable entry zones among dozens, or even hundreds, of invisible 
“charts” (symbol rows) in RadarScreen and notify you to the ones that are about to meet entry. It can even send you an 
alert so you don’t have to wait around. You can then click those symbols to show the corresponding charts. And NOW your 
eyes can do what they do best: Review and qualify the zones and determine if there is a potential trade. 

While SD Zones has elaborate features to SHOW supply/demand zones on charts, its main purpose is to FIND zones in 
RadarScreen among many symbols and timeframes. And thus help you find more trades and/or spend less time. 

Choosing a SettingsPreset 

SD Zones can be made to scan for zones in an almost infinite number of ways, using various combinations of “Zone 
Criteria”. To make it easier for the user, it provides a single SettingsPreset Input to easily select one of several different 
presets (0, 1, 2, 3, 4 or 5) with varying “strictness” of zone criteria; or you can enter 99 to program your own custom values 
of the individual Inputs that control zone criteria.  

See Zone Criteria Preset and Custom Zone Criteria Inputs above. Presets can be changed either through the 
SettingsPreset Input or with the Settings panel. See Quick start: Settings panel above. 

SettingsPreset accepts the following values: 

0: Chart confluence (medium lax) (default) - finds zones suitable as chart confluence with other indicators or signals 
1: HTF zones (lax) - finds any zone, as typically used for High Timeframe charts (HTF) and “opposing zones” 
2: Entry zones (medium) - finds zones suitable as Entry zones, including many that may not qualify 
3: Entry zones (strict) - finds only Entry zones of higher confidence, but may overlook some good zones 
4: Entry zones (extreme) - finds only Entry zones of even higher confidence, but overlooks many good zones 
5: Entry zones (ticks) - tuned specifically for tick-based charts, finds fewer zones than Preset3 
6: Single-bar doji zones - finds only Entry zones with bases consisting of a single doji candle 
99: Custom zone criteria - no preset, use Custom Zone Criteria inputs to program zone detection 

The default SettingsPreset=0 (Chart confluence - medium lax) is meant as a starting point to demonstrate how SD Zones 
works. It is also great for choosing potential trades in confluence with other indicators and trade signals. But it is NOT the 
recommended setting for “pure” supply/demand trading, with zones as the only (or primary) strategy. That’s what the 
other Presets are for: SettingsPreset=1 (Entry zones - lax) for HTF charts, SettingsPreset=2, 3, 4 and 5 (Entry zones - 
Medium, Strict, Extreme and Ticks, respectively) for Entry charts and RadarScreen. Preset4 (extreme) filters out more 
zones than Preset3 (strict), which in turn filters out more zones than Preset2 (medium). All of them filter out more zones 
than Preset0 (medium lax). Preset1 (HTF zones - lax) shows anything that might be a zone, as well as some that aren’t. That 
is deliberate. SettingsPreset=5 (Entry zones - ticks) is specifically tuned for tick-based charts and finds fewer zones than 
Preset3 (strict). SettingsPreset=6 (Single-bar doji zones) is a specialty preset for traders who focus in this pattern. 

If Preset3 (strict) finds higher probability zones than Preset2 (medium) then why not always use Strict? 
Because Preset2 (medium) will give you more potential Entry zones from which to choose. The quality of the Entry zone is 
not the only factor in selecting a good trade setup. 

Does using Preset4 (extreme) guarantee that zones are good enough to trade? 
No! You ALWAYS need to visually inspect and qualify zones found by SD Zones, regardless of preset. They are suggestions 
ONLY, and it will often find zones that are not suitable for a trade, even when using the strict or extreme presets. You ALSO 
need to manually consider High-Timeframe charts (HTF) for any trade, regardless of the quality of the Entry zone. Even the 
best Entry zones can fail in the wrong location or context, or when price is hammering in the opposite direction. And finally, 
you need to apply any other rules you may have on your checklist or trading plan to make sure it is a sensible trade setup. 

Why would you ever use Preset1 (HTF zones - lax) to find zones? 
Because when looking for “opposing zones”, and particularly on High Timeframe charts (HTF), you don’t want to overlook 
zones that might get “in the way”, even if they are of lesser quality and not directly suitable as entry zones.  Even mediocre 
zones on an HTF chart will often cause a sizeable move on a lower timeframe Entry chart. Entry zones, opposing zones (on 
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Entry charts) and HTF zones (on HTF charts) are very different things, used in very different ways. See the supply/demand 
lesson Entry zones vs High Timeframe zones below.  

Tip: Train your eyes to look for the space between HTF zones (magenta colored) more so than the zones themselves. They 
are NOT meant to be Entry zones. 

Use the Entry zone presets (2, 3, 4 or 5) in RadarScreen to locate potential Entry zones coming up 
In RadarScreen, you want to scan for zones that are potential Entry zones, using either SettingsPreset=2, 3, 4 or 5. You can 
set ZoneTypesToShow=0 if you want to include DBR and RBD entry zones (Drop-Base-Rally and Rally-Base-Drop). By 
default such zones are NOT shown with those presets since they are usually not “authentic”, and thus have lower 
probability (see Zone types to show above). 

Note that changes to the SettingsPreset Input (or any Zone criteria Input) must be performed on ALL RadarScreen rows 
and ALL entry charts to make sure they match. Input changes do NOT automatically update on other charts and 
RadarScreen windows.  

With the Settings panel, you can apply changes to ALL charts and/or ALL RadarScreen rows with a single mouse click, 
although it does not change the actual Inputs, but merely “overrides” them. See Quick start: Settings panel and 
Key/Mouse combo user actions above. 

The SD Radar workspaces have all this set up for you, and may be better starting points than adding the indicator to 
your existing chart windows and expecting to find good trade setups. 

Why do some seemingly good zones fail? 

A supply/demand zone on an Entry chart is NOT in itself a trade setup! Most zones on any given chart will cause only small 
bounces rather than major reversals, even great looking zones. That is true regardless of whether they’re found by SD 
Zones or with your eyes. 

The secret to successful supply/demand trading is getting DIRECTION right, and then choose only entry zones in that 
direction. The best way to get direction right is with High Timeframe charts (HTF). See Entry zones vs High Timeframe 
zones below. 

HTF zones do NOT have nearly the same requirements (criteria) as entry zones. The SD Zones indicator has separate 
presets for HTF Zones (Lax, for HTF charts) and Entry zones (Medium, Strict or Extreme for Entry charts). See Zone Criteria 
Preset and Choosing a SettingsPreset above. 

Using HTF charts to determine trade direction is THE most important way to filter out entry zones that are likely to fail, 
and trade only ones that are likely to hold. 

Why does SD Zones overlook some good zones? 

As described repeatedly in this document, zones found by SD Zones MUST be reviewed and qualified by the eyes of a 
trader skilled in the supply/demand technique before they’re considered for trading. 

SD Zones and its workspaces are powerful tools to help find zones in RadarScreen which MIGHT be potential trade setups. 
But there is no magic in how it detects a zone: Leg-in, Base, Leg-out, then verify that the zone structure qualifies according 
to the selected Zone criteria. If SD Zones overlooks a zone or incorrectly detects one, it is usually because it failed to 
properly distinguish a leg bar from a base bar – which is a very hard thing to do in code. Just invalidate the zone in those 
cases, do not believe the indicator to know something you don’t. See Invalidating and restoring zones under Quick start: 
ZoneMenu above. 

There ARE situations, though, when SD Zones does a great job of spotting things that our eyes might overlook: 

• When charts are squashed vertically, our eyes have a hard time distinguishing base bars from leg bars. However, the 
indicator is not fooled by the visual scaling. Sometimes you have to stretch the chart to see and review the zones it finds. 

• When a zone is too shallow relative to current volatility (ATR) SD Zones will either skip the zone entirely OR adjust its 
height to make it more realistic. You will see the Outside line shifted further out in those cases. This is NOT a bug. If you 
are curious, this behavior can be adjusted with the Inputs MinZoneHeightSkipTicks, MinZoneHeightSkipATR and 
MinZoneHeightAdjATR. See Input settings (complete list) above. 

• Sometimes small bars form what appears to be a base, but they are really part of a gap, and so they are not base bars at 
all. The real supply/demand (if there is one) is at the origin of the gap. SD Zones usually detects those situations correctly. 
Multiple base bars in the middle of a long move (whether or not they include gaps) are often less reliable as zones. 
They’re what we call “sitting ducks”. 
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What do dotted and dash-dot-dot zone lines mean? 

Supply/demand zones are normally shown with solid Inside and Outside lines. As the zones are later revisited by price 
(“touched” or “almost touched”), SD Zones will change the line style of Inside lines from solid to dotted, to show that the 
zone is no longer “fresh”. If a zone is revisited several times, or if price touches deeper into the zone, it will be invalidated, 
marked by its Outside line changing to a dash-dot-dot style.  

The dash-dot-dot outside line is SD Zones telling you that the zone should no longer be trusted as entry zone!  

Sometimes invalidated zones may turn out to work again later, but their probability of doing so are lower than fresh zones. 

The reason these zones are kept on the chart is that they should still be observed as “opposing zones” which can affect the 
profit of trades in the opposite direction. If you prefer to keep your charts clean and not show invalidated zones (ones with 
dash-dot-dot Outside lines) you can change the ShowInvalidatedZones Input to False. The Settings panel will let you do 
this is just a few mouse clicks. See Quick start: Settings panel above. 

If a zone is broken (traded though) its lines will be truncated at the bar that broke them, so that you can see what 
happened to it. The lines will then be removed on the next bar. 

See Line styles and zone “freshness” above. 

What’s up with the merged zones? 

SD Zones will merge (combine) zones that are close to each other – or when a new zone is formed wholly or partially inside 
a “further out” zone. Merged zones are shown with shared Inside and Outside lines, but showing individual Base Hilites. 
See Visual chart settings above for an example screen and descriptions of these terms. 

Sometimes multiple zones can end up being merged, particularly on HTF charts which include DBR and RBD zones (not 
shown on entry charts by default). This can look confusing, but simply reflects the reality of a series of partially depleted or 
“stacked” zones, and is generally preferable to showing all the zones individually. Eventually price will clear them all away. 

On entry charts you generally want to consider merged zones as one: You can enter at the Inside line of each individual 
zone, but your stop MUST be beyond the Outside line of the “outermost” zone to avoid stopout. This often makes the risk 
too high. All else being equal, “outer” zones are generally safer trades than “inner” zones. 

On HTF charts, merged stacks of zones are of less concern, since HTF zones are not used as Entry zones anyway. Look more 
for the space between HTF zones rather than the zones themselves. 

How close zones must be in order to be merged by SD Zones is controlled with the MaxDistMergeZones Input. 
SettingsPreset=1 (Lax, HTF) merges zones more aggressively than SettingsPreset=2, 3 and 4 (Medium, Strict, Extreme). 
Regardless of SettingsPreset, MaxDistMergeZones can be changed to override the preset.  MaxDistMergeZones=0 
disables merging altogether. See Merged zones above. 
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Supply/Demand lessons 

Entry zones vs High Timeframe zones 

A great entry zone in itself does NOT make a trade 
Many supply/demand traders struggle to make consistent profits. They may have great trades off some zones, but too 
many of their zones fail and they get stopped out, even when they are seemingly good zones. 

This has led some to conclude that supply/demand doesn’t work as a trading strategy. But the flaw, really, is not paying 
proper attention to the “Big picture” price context at the time when price revisits an Entry zone. 

The truth is that even great looking demand zones will fail when price is collapsing or downtrending. And even great 
looking supply zones will fail when price is rallying or uptrending, even though both may cause small pullbacks at first. 

Many traders then start combining their choice of zones with other indicators to improve their win/loss ratio. This can help, 
but there is a better way: The secret to successful supply/demand trading is getting DIRECTION right, and then trade only 
entry zones in that direction. The best way to get direction right is with High Timeframe charts (HTF). Supply/demand 
analysis on HTF charts can be used to determine a preferred trade direction and eliminate entry zones in the wrong 
direction, which are more likely to fail. 

There are several schools on multiple timeframes, including some very complex ones. A simple but powerful one is this: 

1. Select a High Timeframe chart (HTF) approximately five times the Entry Timeframe chart. For example, 60 min HTF 
charts for 5-10 min entry charts; Or 120 min HTF charts for 15-20 min Entry charts; Or Weekly HTF charts for Daily Entry 
charts. 

2. Look for the nearest supply and demand zones on the HTF chart. These zones do NOT have to be perfect. In fact, do 
not overlook “maybe” HTF zones since they may still cause a sizeable reaction on the Entry chart, being on a higher 
timeframe. Drop-Base-Rally and Rally-Base-Drop zones (DBR and RBD) are acceptable, even though they are usually just 
a reaction to earlier zones. HTF zones provide the highest probability signal when they are “fresh”, i.e. they have not 
seen prior revisits; but do NOT overlook them even when they aren’t fresh. 

3. Look only for LONG trades on the Entry chart (pullbacks to Demand zones) when price is moving from HTF demand to 
HTF supply. Look only for SHORT trades on the Entry chart (pullbacks to Supply zones) when price is moving from HTF 
supply to HTF demand. This is the preferred trade direction. Ignore Entry zones that do not align with it. 

4. If price is approaching its opposing HTF zone, say if it has covered 75% of the distance from HTF demand to HTF supply, 
stop trading in that direction and wait for price to turn around from the HTF zone before trading the opposite direction. 
Sometimes it may turn just before reaching an HTF zone (“almost touch”). If price DOESN’T turn, and instead breaks 
through the HTF zone, direction usually remains the same until the next opposing HTF zone. 

5. Ensure plenty of distance between opposing HTF zones. This determines the profit margin as well as the probability of 
the trade working out. 

In essence, look ONLY for Entry zones that join the larger moves predicted by HTF zones. Imagine you’re trading the HTF 
chart, just using the Entry chart to find an entry into the move on the HTF chart. 

We refer to such trades as trend trades, since you always enter on a pullback to a supply/demand zone in the preferred 
trade direction (which is usually, but not always, the technical trend on the Entry chart). See example charts below. 

This is a simplified description and doesn’t factor in HTF trend or zones on the next-higher timeframe chart, both of 
which can significantly affect price movement. But it is simple and can be very effective. 

Distinguishing Entry zones and HTF zones on charts 
SD Zones has separate rules (presets) for Entry zones and HTF zones (See Zone Criteria Preset above) and uses different 
colors to distinguish them on charts: Cyan for Entry zones and Magenta for HTF zones. HTF zones can be shown on 
separate HTF charts OR overlaid on Entry charts. See HTF zones overlaid on Entry charts above and the example charts 
below. 
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Examples of Trend trades: Shorting a supply zone (left) when price is moving DOWN from HTF supply towards HTF demand; 
and buying a demand zone (right) when price is moving UP from HTF demand towards HTF supply (ignoring the temporary 
downtrend on the Entry chart: Lower highs with lower lows).  Entry and HTF zones have different colors: cyan for Entry 
zones, magenta for HTF zones. HTF zones can be “overlaid” (superimposed) on Entry charts, as shown here. Zoom in to see 
the zone lines and descriptions. 

When HTF direction is unclear 
You will often find situations where the HTF zones on the HTF chart do NOT provide a clear direction signal according to the 
above rules. Say, the HTF zones are not fresh or otherwise unclear (so-called “twilight zones”); or the HTF zones are too 
close to each other or even overlapping (as can happen); or any number of countless other situations that do not provide a 
clear picture. The choice in those situations is one of the easiest in all of trading: Sit on your hands, and do not trade 
setups that are doubtful. Instead, move on to review the next potentially tradable zone in the RadarScreen list. 

Look for the SPACE between HTF zones 
Train your eyes to look for the space between HTF zones more so than the zones themselves. As long as we are merely 
looking for trend trades, the HTF zones are NOT meant to be Entry zones. 

SD Zones uses very “lax” zone criteria when finding HTF zones, which often results in zones that make you scratch your 
head, wondering if they are really proper supply/demand zones. And the answer is often they are NOT, and that is 
deliberate. We want to find even “maybe” zones on HTF charts, since they may still cause a sizable move on Entry charts. 

You will also find that SD Zones liberally merges HTF zones that are close to each other, drawing a single Inside line for the 
“innermost” merged zone, and a single Outside line for the “outermost” merged zone. This can be confusing at first, but is 
preferable to adding even more lines to the chart. If you dislike it, you can disable merging using the Settings panel. See 
Quick start: Settings panel above. 

Trend vs Countertrend trades 
The above rules are for trend trades: they join an existing move on HTF charts, which is often matched by an actual trend 
on the Entry chart. The classic “book definition” of trend is higher lows with higher highs for UPTREND, and lower highs 
with lower lows for DOWNTREND.  

But sometimes a temporary trend forms on the entry chart which DOESN’T match the preferred trade direction signaled by 
the HTF zones, as shown in the above example to the right. Or the HTF zones signal a new direction (UP or DOWN) but an 
actual trend has not yet formed on the Entry chart. Simply following the HTF direction in those cases is recommended, 
which can yield some excellent trades, but also incur some losers. Or you can choose to filter them out as doubtful setups, 
which will avoid those losers, but also forgo some excellent trades. The choice is yours, depending on your trading style. 

Some of the best supply/demand trades can be countertrend trades off quality HTF zones, when quality Entry zones are 
found inside them. This is the ONLY time to trade against the current HTF direction. Such trades often have impressive 
reward/risk ratios, but they are more aggressive and have other rules to ensure a high probability of working out. Among 
other things, you want to consider trend on the HTF chart itself AND zones on the next-higher timeframe chart. 

HTF demand zone 

 

Price was moving 
DOWN from an 
HTF supply zone 
towards an HTF 
demand zone 
(magenta lines) 

ONLY trade 
pullbacks to 

qualified Entry 
SUPPLY zones 

(cyan lines) 
Once price begins 
moving UP from an 
HTF demand zone, 
trade ONLY pullbacks 
to Entry DEMAND 
zones (none here) 

Only look for Entry 
DEMAND zones  

Price is moving 
UP from an HTF 
demand zone 
towards an HTF 
supply zone 
(magenta lines) 

HTF supply zone (to the left) 

 ONLY trade pullbacks to qualified 
Entry DEMAND zones (cyan lines) 

IGNORE Entry SUPPLY zones until 
price has begun turning DOWN 
from an HTF supply zone 

HTF demand zone 
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Look for the EASY money 

Watch how price ARRIVES into your Entry zone 
Next to HTF direction, the most important consideration in qualifying a zone as a trade setup is ensuring sufficient distance 
from your ENTRY zone to the OPPOSING zone (or opposing support/resistance). This is the “easy money” and you want 
lots of it! You absolutely DON’T want opposing zones close to your Entry zone. 

Requiring a distance of at least 3:1 relative to the height of the Entry zone is reasonable. More is better! Either way should 
your first target be comfortably before the opposing zone. 

If you’re trading in the right HTF direction, price often breaks through opposing zones (which we like) and keeps going to 
the opposing HTF zone. That’s great for multiple targets, but is of course never guaranteed. So best to ensure plenty of 
distance between your Entry zone and the nearest opposing zone. Plenty of EASY money! 

As with HTF zones, you want to be Lax when looking for opposing zones (certainly not Strict) to make sure nothing gets in 
the way of your targets.  

There is no “best” timeframe or interval 

Look “inside” zones to verify their structure 
Some trading schools teach the importance of sticking to a single timeframe or interval. Consistency is indeed important in 
trading, but with supply/demand we are simply looking for “footprints” of institutions possibly accumulating or 
distributing. Sometimes that footprint isn’t clear on a 5 min chart, but is there on a 10 min chart, simply because of how 
the bars line up. 

So you absolutely SHOULD consider several timeframes/intervals when looking for zones! 

Our solution is to have RadarScreen symbol rows scanning for zones on several different intervals of the same symbol (say 
5, 10, 15, 20 min for day trading). If there is accumulation or distribution at a given price level, chances are the pattern 
we’re looking for will be there on at least one of these intervals. Now you just have to qualify it on a chart and match it to 
the preferred trade direction using HTF charts.  

Note that this is NOT what is meant by “Multiple Timeframes”, which refers to an Entry Timeframe and one or several High 
Timeframes for “Big Picture” price context. This is just looking at multiple timeframes/intervals to find footprints of 
institutions accumulating/distributing (Entry zones). 

Once you have found a good Entry zone (say on a 10 min chart) it is also important to look “inside it” on a smaller interval 
(say 5 min) to see if the internal structure is still good AND whether the zone extends higher or lower than what is apparent  
on the 10 min chart. Based on this, you can adjust your zone higher or lower (entry and stop levels) to improve your 
probability of BOTH getting filled AND avoiding stopout. 

SD Zones doesn’t perform this kind of “deep scanning”. It’s not impossible to do in code, but would be very slow for 
TradeStation to process, and thus defeat the purpose of the indicator. 
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